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Introduction

Note

Trademarks

Revisions

1st Edition : March 2004 (YK)

Thank you for purchasing the Engine Combustion Pressure Analysis.
This user’s manual contains useful information about the functions and operating
procedures of the software. To ensure proper use of the software, please read this
manual thoroughly before beginning operation. After reading the manual, keep itin a
convenient location for quick reference in the event a question arises.
This software loads files (.hdr and .wvf files) containing engine combustion pressure data
that was measured by the DL708E, DL716, DL750, or WE7000 and performs analysis.
The analysis results can be saved in CSV format and easily opened by a spreadsheet
program such as Microsoft Excel. The type of engines that can be analyzed differ
depending on the measuring instrument as follows:

DL708E: Max. 6 cylinders

DL716, DL750, WE7000: Max. 8 cylinders

» This manual applies to version 4 of the Engine Combustion Pressure Analysis or
Monitor Function of Engine Combustion Pressure.

« The contents of this manual are subject to change without prior notice as a result of
improvements in the software’s performance and functions. Display contents
illustrated in this manual may differ slightly from what actually appears on your screen.

« Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA representative listed on the back cover of this
manual.

» Copying or reproduction of all or any part of the contents of this manual without the
permission of Yokogawa Electric Corporation is strictly prohibited.

« Microsoft, Windows, and Windows NT are trademarks or registered trademarks of
Microsoft Corporation in the United States and/or other countries.

« Adobe and Acrobat are trademarks of Adobe Systems Incorporated.

* The company and product names used in this manual are not accompanied by the
trademark or registered trademark symbols (") and (®))

« Other company and product names are trademarks or registered trademarks of their
respective holders.

1st Edition March 2004

All Rights Reserved, Copyright © 2004 Yokogawa Electric Corporation
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Overview of This Manual
This manual consists of seven chapters and an appendix as described below.

Chapter Title Description

1 System Configuration Describes the various hardware and software
configurations needed for different applications of the
software.

2 Overview Provides an overview of software functions as well as

an explanation of the software setup procedure, the
directory structure, and the software screens.

3 Screens and Operations Gives descriptions of the various screens included in
the software, and how they are used.

CSV Files Provides a list of items that can be saved to .csv files.
Equations Explains how each item is calculated.

Monitor Function (Add-On) Gives an overview of the monitor function and how to
set it up, and provides an explanation of the various
software screens associated with the monitor function
and how to operate them.

7 Error Messages Provides a list of error messages.
Appendix Explains how to set up the WE7000 and DL750.
Index

Conventions Used in This Manual
» The following symbols and codes are used in the tables that describe the software’s
settings and display data.
« Data Type
C : Character string
I: Integer
F : Floating point

¢ Size
For numerical data
10.2

L Number of digits displayed before the decimal point (no. of bytes)
Total number of characters displayed (including the decimal point,
+/- signs, e and E)(no. of bytes)

For character strings
38
L Maximum number of bytes
* When necessary for clarity, key names of the measuring instrument and items that
appear on screen are set in boldface.
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Terms and Conditions of the Software License

NOTICE - PLEASE READ CAREFULLY BEFORE USE

Thank you very much for purchasing this medium containing a software program and related documentation provided by Yokogawa Electric
Corporation (hereinafter called “Yokogawa”), and the program contained, embedded, inserted or used in the medium (hereinafter called the
“Yokogawa Software Program”).

By opening this package or plastic wrapping (hereinafter called “Package”) enclosing the Yokogawa Software Program, you acknowledge that you
understand and agree to the “Terms and Conditions of the Software License” (hereinafter called “Terms and Conditions”) which is written in the
documentation and separately attached. Accordingly, the Terms and Conditions bind you.

The Yokogawa Software Program and its related documentation including ownership of copyright shall remain the exclusive property of Yokogawa
or those third parties from whom sublicensed software in the Yokogawa Software Program is licensed.

Yokogawa hereby grants you permission to use the Yokogawa Software Program on the conditions that you agree to the Terms and Conditions
before you open the Package and/or install it in or onto a computer.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS, YOU CANNOT OPEN THE PACKAGE, AND MUST IMMEDIATELY RETURN IT
TO YOKOGAWA OR ITS DESIGNATED PARTY.

Terms and Conditions of the Software License

Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software
Program (hereinafter called the “Licensed Software”) to the Licensee on the conditions that the Licensee agrees to the terms and conditions
stipulated in Article 1 hereof.

You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions for the software license (hereinafter called
the “Agreement”) based on the use intended for the Licensed Software.

Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event
shall Yokogawa intend to sell or transfer the Licensed Software to the Licensee.

Licensed Software Name: Engine Combustion Pressure Analysis (model: 707766), Monitor Function of Engine Combustion Pressure (model:
707769)

Number of License: One each

Article 1 (Scope Covered by these Terms and Conditions)

1.1 The terms and conditions stipulated herein shall be applied to any Licensee who purchases the Licensed Software on the condition that the
Licensee consents to agree to the terms and conditions stipulated herein.

1.2 The “Licensed Software” herein shall mean and include all applicable programs and documentation, without limitation, all proprietary
technology, algorithms, and know-how such as a factor, invariant or process contained therein.

Article 2 (Grant of License)

2.1 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the
license fee separately agreed upon by both parties.

2.2 The Licensee is, unless otherwise agreed in writing by Yokogawa, not entitled to copy, change, sell, distribute, transfer, or sublicense the
Licensed Software.

2.3 The Licensed Software shall not be copied in whole or in part except for keeping one (1) copy for back-up purposes. The Licensee shall
secure or supervise the copy of the Licensed Software by the Licensee itself with great, strict, and due care.

2.4 In no event shall the Licensee dump, reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee
may translate the Licensed Software into other programs or change it into a man-readable form from the source code of the Licensed
Software. Unless otherwise separately agreed by Yokogawa, Yokogawa shall not provide the Licensee the source code for the Licensed
Software.

2.5 The Licensed Software and its related documentation shall be the proprietary property or trade secret of Yokogawa or a third party which
grants Yokogawa the rights. In no event shall the Licensee be transferred, leased, sublicensed, or assigned any rights relating to the
Licensed Software.

2.6 Yokogawa may use or add copy protection in or onto the Licensed Software. In no event shall the Licensee remove or attempt to remove
such copy protection.

2.7 The Licensed Software may include a software program licensed for re-use by a third party (hereinafter called “Third Party Software”, which
may include any software program from affiliates of Yokogawa made or coded by themselves.) In the case that Yokogawa is granted
permission to sublicense to third parties by any licensors (sub-licensor) of the Third Party Software pursuant to different terms and conditions
than those stipulated in this Agreement, the Licensee shall observe such terms and conditions of which Yokogawa notifies the Licensee in
writing separately.

2.8 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software,
including any copy thereof.

Article 3 (Restriction of Specific Use)

3.1 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for
the purpose of the following events:

a) Operation of any aviation, vessel, or support of those operations from the ground;,

b) Operation of nuclear products and/or facilities;,

c) Operation of nuclear weapons and/or chemical weapons and/or biological weapons; or
d) Operation of medical instrumentation directly utilized for humankind or the human body.

3.2 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or
responsibility for any demand or damage arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own
responsibility, to solve and settle the claims and damages and to defend, indemnify or hold Yokogawa totally harmless, from or against any
liabilities, losses, damages and expenses (including fees for recalling the Products and reasonable attorney’s fees and court costs), or claims
arising out of and related to the above-said claims and damages.

Article 4 (Warranty)

4.1 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered. If defect(s), such
as damage to the medium of the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any
Licensed Software on condition that the defective Licensed Software shall be returned to Yokogawa's specified authorized service facility
within seven (7) days after opening the Package at the Licensee’s expense. As the Licensed Software is provided to the Licensee on an “as
is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the Licensed Software, including without limitation,
data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated.
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Terms and Conditions of the Software License

4.2 Notwithstanding the preceding Paragraph 4.1, when third party software is included in the Licensed Software, the warranty period and terms
and conditions that apply shall be those established by the provider of the third party software.

4.3 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Revision
upgrades and Version upgrades separately specified by Yokogawa (hereinafter called “Updates”).

4.4 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted
renovation or improvement of the Licensed Software.

4.5 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE,
WRITTEN, ORAL, OR IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD
PARTY SOFTWARE TO YOKOGAWA.

4.6 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for
any failure of Yokogawa to comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing
the Third Party Software to Yokogawa (including any liability for direct, indirect, special, incidental or consequential damages) whether in
warranty, contract, tort (including negligence but excluding willful conduct or gross negligence by Yokogawa) or otherwise with respect to or
arising out of the use of the Licensed Software.

Article 5 (Infringement)

5.1 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under
patent right (including utility model right, design patent, and trade mark), copy right, and any other rights relating to any of the Licensed
Software, the Licensee shall notify Yokogawa in writing to that effect without delay.

5.2 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate
with the claiming party. Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for
Yokogawa's defense and negotiation. If and when such a claim should be attributable to Yokogawa, subject to the written notice to
Yokogawa stated in the preceding Paragraph 5.1, Yokogawa shall defend the Licensee and negotiate with the claiming party at Yokogawa’'s
cost and expense and be responsible for the final settlement or judgment granted to the claiming party in the preceding Paragraph 5.1.

5.3 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa'’s
judgment there is possibility of such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at
Yokogawa's cost and expense.

a) To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use
the Licensed Software;

b) To replace the Licensed Software with an alternative one which avoids the infringement; or

c) To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa
shall indemnify the Licensee only by paying back the price amount of the Licensed Software which Yokogawa has received from the
Licensee. THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING
THIRD PARTY SOFTWARE TO YOKOGAWA WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS
INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)

6.1 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided
to the Licensee under the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this
Agreement. However, in no event shall Yokogawa be liable or responsible for any special, incidental, consequential and/or indirect damage,
whether in contract, warranty, tort, negligence, strict liability, or otherwise, including, without limitation, loss of operational profit or revenue,
loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss or cost of interruption of the Licensee’s
business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of customers of
Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa
and to the extent of this Article 6, Yokogawa'’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software
or service fee which Yokogawa has received. Please note that Yokogawa shall be released or discharged from part or all of the liability under
this Agreement if the Licensee modifies, remodels, combines with other software or products, or causes any deviation from the basic
specifications or functional specifications, without Yokogawa's prior written consent.

6.2 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless
Yokogawa is notified of the claim within one (1) year of its occurrence.

6.3 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts
between the Licensee and its customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other
than those where Yokogawa permits export in advance.

Article 8 (Term)

This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until
terminated as provided herein, or the Licensee ceases using the Licensed Software by itself or with Yokogawa'’s thirty (30) days prior written notice
to the Licensee.

Article 9 (Injunction for Use)

During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems
that the Licensed Software is used improperly or under severer environments other than those where Yokogawa has first approved, or any other
condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to
perform this Agreement. However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)

Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved
amicably through negotiation between the parties upon the basis of mutual trust. Should the parties fail to agree within ninety (90) days after
notice from one of the parties to the other, both parties hereby irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main
office) in Japan for settlement of the dispute.

Article 12 (Governing Law)

This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely
and irrevocably and to the fullest extent permissible under applicable law any rights against the laws of Japan which it may have pursuant to the
Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be
null and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.
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Chapter 1 System Configuration

1.1

Hardware Configuration

You can set the TDC pulse as the trigger, then synchronize the engine cylinder pressure
and other signals to the angular pulse and perform measurement.

EXT-CLK

Angular pulse
1.0 CA

0.5 CA
0.25CA
0.1 CA

/_14
WE7000

TRIG

TDC pulse

|_>

Sensor

thernet

\

P-V graph

L 4
Monitor Function of
Engine Combustion Pressure

Numeric analy5|s

Cylinder pressure
(up to 8 cylinders)

Intake manifold pressure

Other signals

( DL708E \
DL716

Y

Actual driving

Engine

4-cycle/2-cycle engines

Gasoline/Diesel/LPG/LNG engines

Continuous operation

Dynamo

*« PC System
Os:

Requirements

—

WVF files

O«
CSV files

* Numeric analysis

* Crank angle graph

e Cycle graph

* Crank angle graph
of all cycles

Off line

Engine Combustion
Pressure Analysis

Crank angle graph

Cycle graph

3D graph

Windows XP, Windows 2000 Pro, Windows NT 4.0, Windows 98

However, Windows NT 4.0 is not supported when using USB.

CPU:

Memory: 256 MB or more
Hard disk: 2 GB or more of free space

* For the DL708E/DL716
e Main Unit
DL708E or DL716 (with internal hard disk)
Memory length > (no. of analyzed cycles + 3) x 1 cycle data length
For 4-cycle engines: 1 cycle data length = (360/res) x 2
For 2-cycle engines: 1 cycle data length = (360/res)
¢ Measurement module
701852/701853
However, ((RPM/60) x 360/res) < 100 kHz
res : angular resolution (1, 0.5, 0.25, 0.1)

Pentium 1ll, 1 GHz or higher
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1.1 Hardware Configuration

e For the DL750

Main Unit
DL750 (with a Zip drive, PC card slot, or internal hard disk)
Memory length > (no. of analyzed cycles + 3) x 1 cycle data length
For 4-cycle engines: 1 cycle data length = (360/res) x 2
For 2-cycle engines: 1 cycle data length = (360/res)
Measurement module
701251
However, ((RPM/60) x 360/res) < 1 MHz
res : angular resolution (1, 0.5, 0.25, 0.1)

¢ For the WE7000

Main Unit
WEB800 or WE400 (1 unit)
Communications I/F
WE7035/WE7036, WE7037/WE7038, or WE7052
Measurement module
WE7235, WE7245, WE7271/WE7272
However, ((RPM/60) x 360/res) < 100 kHz
WE7275
However, ((RPM/60) x 360/res) < 1 MHz
res : angular resolution (1, 0.5, 0.25, 0.1)
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1.2 Software Configuration

Engine Combustion Pressure Analysis

Loading Measurement Data

You can load saved .wvf files (Yokogawa’s proprietary format) containing cylinder
pressure data from a 4-cycle or 2-cycle engine measured on the DL708E, DL750, or
WE?7000.

A portion of this data (up to 800 cycles worth) can be extracted for filter processing,
rotational offset correction, or TDC correction, then analyzed.

By running the Monitor Function of the Engine Combustion Pressure Analysis
Package, you can analyze previously saved WVF files at the same time.

Loading and Saving Analysis Conditions

You can save and load analysis conditions (TDC correction value, interval of absolute
pressure correction, analysis parameters, calculation data items, display window
layout, and graph display conditions). The analysis conditions from the previous
session are automatically loaded upon start-up.

Filter Processing

You can shape the waveform by applying filters (None, Lowpass, Bandpass,
Highpass) to motoring and firing pressure data, then perform rotational offset
correction, TDC correction, and combustion pressure analysis calculations.

TDC Correction

Using motoring data, you can determine the offset between the TDC pulse position
and the actual TDC position, then perform analysis. Or, you can enter the offset value
manually.

Absolute Pressure Correction, Physical Value Conversion, and other Signals
You can assign channels to measurement signals. You can assign channels 1
through 16 to cylinder pressure (up to 8 cylinders), intake manifold pressure, intake
manifold temperature, fuel consumption, rpm, and other signals. Also, you can
specify the coefficients for conversion to physical values (calibration factors, A and B
in y=Ax+B). Cylinder pressure is corrected to absolute pressure.

Combustion Pressure Analysis/Results Display

¢ You can select multiple combustion pressure analysis items or input them
manually, then perform combustion pressure analysis.

« After the analysis, you can select computed items one at a time for graphical or
numerical display.

« New manually input items and analysis items can be entered or selected so that
additional calculations can be performed.

Saving Analysis Data in CSV Format
You can save test information (settings at time data was saved), manually input items,
and calculated analysis results data in CSV format.

IM 707766-61E
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1.2 Software Configuration

Monitor Function of Engine Combustion Pressure
The Monitor Function of Engine Combustion Pressure (hereinafter, the Monitor Function)
is an add-on for the Engine Combustion Pressure Analysis.
This function is only available when used in conjunction with the Engine Combustion
Pressure Analysis.
With the Monitor function, you can use your WE7000 series instrument (WE7235,
WE7245, WE7271, WE7272, or WE7275) or the DL750 to measure cylinder pressure
over given periods of time during motoring or firing, and continuously monitor the
measurements. You can also save the resultant data. For details, see chapter 6.
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Chapter 2 Overview

2.1 Overview of Functions

Procedure
Motoring Firing
Motoring cylinder Firing cylinder
pressure measurement pressure measurement
s | _wwriles
TDC correction Enter manually input
angle calculation data items
Set coefficients for .
p h Combustion
convertion to physical values ;
(calibration factors) pressure analysis
Y Y
i TDC correction .
Set angle range for interval of |_ Vol Save results to CSV file

absolute pressure correction

Conversion
coefficients
(calibration factors)

Correction interval

Loading Measurement Data
You can select a specific cycle range from the waveform data that was measured and
saved by the DL708E, DL716, DL750, WE7000, and load that selected portion of the
data into the software.
* Motoring data
Data for TDC correction
« Firing data
Data for combustion pressure analysis (signals coming from each channel, starting
with CH1, in the firing order)
* Number of cylinders: Up to 8 cylinders (or up to 6 cylinders for the DL708E)
¢ No. of cycles: Up to 800 cycles
« Angular resolution: 1, 0.5, 0.25, 0.1 CA
With this software, you cannot check whether or not the data meets the above
conditions.

amano H
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2.1 Overview of Functions

Filter Processing

You can apply filters to motoring data and firing data. When applying filters, the first
cycle’s worth of data is always dropped to cancel out the effect of signal rise. The
remaining data is treated as the raw data, and used for rotational offset correction, TDC
correction, and combustion pressure analysis.
« Filter types

None, Lowpass, Bandpass, Highpass
» Characteristics

4™ order (24 db/oct) butterworth

« Cutoff frequency

* At 1 CA resolution, 7.2 order (times) of the number of revolutions (2%) — 72 order
(times) (20%)

e At 0.5 CA resolution, 14.4 order (times) of the number of revolutions (2%) — 144
order (times) (20%)

* At 0.25 CAresolution, 28.8 order (times) of the number of revolutions (2%) — 288
order (times) (20%)

e At 0.1 CA resolution, 72 order (times) of the number of revolutions (2%) — 720
order (times) (20%)

* The percentage in parentheses is the ratio relative to the sampling frequency.
% = specified multiple / ( 360 degrees / angular resolution (1, 0.5, 0.25, 0.1) ) x 100

For example, to apply a low pass filter with a 1 kHz cutoff:
At 3000 rpm (equivalent to 50 Hz),
Cutoff = 1 kHz divided by 50 Hz = 20 times the rpm.

When this process is carried out, the TDC correction value is calculated using the filtered
data, and all analyses are performed.

Measurement Data Review

To facilitate checking of measured data, the motoring and firing data are displayed in the
crank angle graph.
If filters were applied, filtered waveforms are displayed.

Rotational Offset and TDC Correction (Calculated on Motoring Data)

Since rotation pulse (TDC) signals are output once per revolution, there is an offset of
1/2 cycle for each single cycle of intake, compression, explosion, and exhaust.
Therefore, the crank angle at the maximum point of pressure is determined from within
one cycle’s worth of data, and if there is a pressure peak on the exhaust or intake stroke,
the first 1/2 cycle’s worth of data is discarded.

Measurement start

Rotation | | l

ulse .
P Discarded data
& 1 » 1 I 1
‘SN ! ” ! ! ! Rotational offset: Yes
| | I | (peak on exhaust or
1 1 1 1 intake stroke)
1 1 ! 1
— 1 — |
Cylinder < = gg > 2 3 gg > 2
pressure data s 2 @ 3 . 7}
[ S : ! S
1 1 1 .
1 1 : 1 Rotational offset: No
: / : | / : (peak on gompression
1 : or explosion stroke)
— | 1 —_ [}
°3 T o3 T
s 5 § & @& "z g 2
) - [%2] ) - [%]
T o - { o -
S5 =}

If the crank angle at the maximum point of pressure <-180 CA or
if +180 CA < the crank angle at the maximum point of pressure,
the rotational offset is set to "yes."
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2.1 Overview of Functions

For the pressure data from the first cylinder during motoring, the software searches for
the maximum pressure value after the rotational offset correction is performed, then
determines the TDC position. It then calculates the offset from the TDC pulse position.
This offset value is used for all analysis thereafter.

» TDC Correction Calculation Method
(1) You can compute the average data for all cycles of the cylinder pressure data from
the motoring data of the first cylinder.

1 cycle of data

data
N VAN AL AL J

Rotation pulse I

Average

cylinder pressure

(2) Using 10 CA's worth of data before and after the maximum pressure point of the
averaged cylinder pressure data, you can apply the least square method to compute
the crank angle of maximum cylinder pressure 6X.

(3) The TDC correction value can be determined using 6X. The TDC correction value is
given as the amount of divergence of the maximum pressure point 6X from the start
of measurement, and a correction value is determined such that the position of 6X is
zero (CA).

See the figure below.
Data after correction

. —>| |« TDC colrection value
Discarded data —>| [« A~
60X o

A

Measurement start

S < Discarded data , Data after correct|on

<«— TDC correctlon
value

IM 707766-61E
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2.1 Overview of Functions

Absolute Pressure Correction

Other Signals

You can convert measured cylinder pressure to absolute cylinder pressure. For
example, cylinder pressure can be corrected so that the average cylinder pressure (on a
per cycle or all cycle basis) of the crank angle range near BDC (which can be specified
by the user) equals the atmospheric or intake manifold pressure. You can manually
input atmospheric pressure (including boost pressure) or use measured intake manifold
pressure.
* When using the per-cycle average value

Pressure after absolute pressure correction = Pfinp, — Padjp + Pxp

Pxn: Atomospheric pressure (including boost pressure) or intake manifold pressure

POin1 POin2 POin3
Cylinder pressure : L L
data degli ideg2 degli ideg2 degli ideg2
> < > — <= Average value across
Padjl Padj2 Padj3 <«— the specified crank angle

range (degl—-deg?2)
* When using the all-cycle average value
Pressure after absolute pressure correction = POinpy — Padj + Pxp
Pxn: Atomospheric pressure (including boost pressure) or intake manifold pressure

P6inl P6in2 P6in3
Cylinder pressure
data
N AN A v
Y Y 2’
| | J
\

Average \J\—’
cylinder pressure ___ Average value across the specified

deﬂﬁ EEEQZ crank angle range (degl-deg2)
Padj «—— atthe average of all cycles

You can specify signals that are not to be used for combustion pressure analysis. There
are no physical units for the channels selected here. Please consider these values to
have whatever units are appropriate for your application. When converting voltage to
physical values, enter the conversion coefficients (calibration factors) A and B for the
equation y=Ax+B. Also, note that absolute pressure correction is not performed on these
signals.

During analysis, cycle-averaged values are displayed in the crank angle graph, the
average value at each cycle is shown in the cycle graph, and the data can be saved in
CSV format. TDC correction is based on the first cylinder.

2-4
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2.1 Overview of Functions

Combustion Pressure Analysis/Results Display

Combustion pressure analysis can be performed after selecting combustion pressure
analysis items and entering manual input items. After analysis, the analysis results for
the selected items are graphically or numerically displayed.

* Combustion Pressure Analysis Data Items
Crank Angle Graph

.

.

.

.

Cylinder pressure

Rate of cylinder pressure rise
Amount of heat release

Rate of heat release

Rate of heat release (Received heat)
Rate of heat release (Heat loss)
Combustion mass rate

Cylinder gas temperature
Polytropic index

Ratio of specific heat

Other signals

P-V Graph

Cylinder pressure - Piston displacement graph
Logarithmic cylinder pressure - Logarithmic piston displacement graph

Cycle Graph

Maximum cylinder pressure

Averaged maximum cylinder pressure of all cylinders

Crank angle at maximum cylinder pressure

Averaged crank angle at maximum cylinder pressure of all cylinders
Maximum rate of pressure rise

Averaged maximum rate of cylinder pressure rise of all cylinders
Crank angle at maximum rate of cylinder pressure rise
Averaged angle at maximum rate of cylinder pressure rise of all cylinders
NMEP

Averaged NMEP of all cylinders

IMEP

Averaged IMEP of all cylinders

PMEP

Averaged PMEP of all cylinders

Maximum amount of heat release

Crank angle at maximum amount of heat release

Maximum rate of heat release

Crank angle at maximum rate of heat release

Crank angle at combustion mass rate N1 %

Crank angle at combustion mass rate N2 %

Crank angle at combustion mass rate N3 %

Other signals

Analysis Data Items Graphed in 3D

Cylinder pressure

Rate of cylinder pressure rise
Amount of heat release

Rate of heat release

Rate of heat release (Received heat)
Rate of heat release (Heat loss)
Combustion mass rate

Cylinder gas temperature

IM 707766-61E
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2.1 Overview of Functions

Polytropic index
Ratio of specific heat
Other signals

Numeric Analysis Data Items

Average cylinder pressure across correction interval

(When calculating the average pressure of the crank angle range determined from
the all-cycle average and applying the result to all cycles)

Piston displacement

Average, standard deviation, and rate of change of the maximum cylinder pressure
Average, standard deviation, and rate of change of the maximum rate of cylinder
pressure rise

Average, standard deviation, and rate of change of NMEP

Average, standard deviation, rate of change, minimum, and LNV of IMEP
Average, standard deviation, and rate of change of PMEP

Rate of misfire

Average, standard deviation, and rate of change of the maximum cylinder gas
temperature

Average, standard deviation, and rate of change of the maximum rate of heat
release

Average, standard deviation, and rate of change of the maximum amount of heat
release

Average, standard deviation, and rate of change of the angle at combustion mass
rate N1%

Average, standard deviation, and rate of change of the angle at combustion mass
rate N2%

Average, standard deviation, and rate of change of the angle at combustion mass
rate N3%

Average start point of combustion (point a)

Average end point of combustion (point b)

Averaged maximum cylinder pressure of all cycles and cylinders

Averaged maximum rate of cylinder pressure rise of all cycles and cylinders
Averaged NMEP of all cycles and cylinders

Averaged IMEP of all cycles and cylinders

Averaged PMEP of all cycles and cylinders

Minimum IMEP of all cycles and cylinders

LNV of IMEP of all cycles and cylinders

Mass of intake fuel

Mass of intake air

Excess air factor

Corrected gas constant

Mass of remaining gas

Manually Input Data ltems

TDC correction values

Conversion coefficients (calibration factors A and B)
Unused channels

Starting angle of correction interval

Ending angle of correction interval

Con-rod length

Bore

Piston offset

Stroke length

Clearance volume

2-6
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2.1 Overview of Functions

Compression ratio

Method of absolute pressure correction
Number of data items for judging start point of combustion
Number of data items for judging end point of combustion
Fuel consumption

Gas constant

Atmospheric temperature

Atmospheric pressure

Suction volumetric efficiency

Revolutions per minute

Specific gravity

Boost pressure

Exhaust gas pressure

Exhaust gas temperature

Supercharger inlet temperature

Boost temperature

Supercharger inlet pressure

Piston head ratio

Cylinder wall temperature

Cylinder head wall temperature

Piston head wall temperature

Heat release at lowest position
Presence/absence of supercharging
Presence/absence of heat loss processing

Ratio for judging angle of combustion mass rate (3 locations)

Value for judging misfire

Saving Analysis Data in CSV Format
You can save absolute pressure analysis data in CSV format (.csv files). You can enter
test information prior to saving. The following seven types of items can be saved. Raw
data cannot be saved.
Test Information

Test date

Data name
Testing personnel
Department

Test name
Engine type
Serial No.

Place of test

Test bench type
Comments

Manually Input Data Items
Numeric Analysis Data Items
Crank Angle Graph Data

Cycle Graph Data

Analysis Data for Other Signals

Measured Intake Manifold Pressure, Intake Manifold Temperature, Fuel

Consumption, Exhaust Gas Pressure, Exhaust Gas Temperature, Supercharger

inlet pressure, Supercharger inlet temperature, and Revolutions per Minute

IM 707766-61E
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2.1

Overview of Functions

Saving the Analysis Results of a Specified Range of Cycles

For the ten items below, the crank angle graph data from a specified range of cycles can

be saved in CSV format (as .csv files).
¢ Cylinder pressure
« Logarithmic cylinder pressure
« Rate of cylinder pressure rise
¢ Cylinder gas temperature
e Amount of heat release
* Rate of heat release
« Rate of heat release (received heat)
« Rate of heat release (heat loss)
« Combustion mass rate
« Ratio of specific heat

Saving Analysis Conditions

You can save conditions required for analysis in text format (as .ecp or .ecm files).

.ecp: When running the Engine Combustion Pressure Analysis only

.ecm: When running the Monitor Function of Engine Combustion Pressure Analysis

e TDC correction value
¢ Number of cylinders
« Interval of absolute pressure correction

« Coefficients for conversion to physical values (calibration factors)

< Filter setting conditions

e Calculation parameters

« Calculation execution items

« Analysis graph display conditions
e Screen layout

2-8
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2.2 Setup

Use the setup program on the CD to install the Engine Combustion Pressure Analysis.
Run the file, CD Drive IDisk1/Setup.exe.

If your operating system is Windows NT, 2000, or XP, log in as the administrator.

If a previous version of the software is already installed, you must remove it before
installing this version.

IM 707766-61E
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2.3 Directory Structure

This software utilizes the following directory structure.
<Installation directory> (directory name specified during installation)’
— <Info>: .ini file directory
— <log>: Log file directory (error log, message log)
— <work> (for use by application)

I—<Ca|> (for use by application)

— <IM>: User's manual directory (this manual, in PDF format)

L— <Sample>: Motoring/firing sample data directory

* If a previous version of the software is already installed, you must remove it before installing
this version.

Tt Only alphabetical characters and numbers may be used for the name of the installation
directory.
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2.4 Screens

Menu Bar and Icons for the Engine Combustion Pressure Analysis

File menu

Edit menu

View menu

Settings menu
Calculation menu
Graph menu
Window menu
Help menu

amano H

lication Software Package for Analysis of Engines' Combustion Pressure - demol - |EI|1|

File Edit Yiew Setfings Calculation Graph  Window Help

[EaEs R BB EREL Y @ wos = W »E =2 |
|

Help (display user's manual)
Restore the minimized window
Minimize the window
Save screen to BMP file
Move cursor

Start monitor function
Enter color settings
Enter cycle display settings
Enter axis range settings
Enter 3D graph settings

Execute calculation

Enter parameter settings

TDC and calibration factor settings

Enter filter settings

Save analysis conditions

Load analysis conditions

Save to CSV file

Load waveform data
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Chapter 3 Screens and Operations

3.1

Common Operations

Right-Clicking the Mouse
If you right-click on a window displaying a graph, the following shortcut menu appears.

Measured Data 3
Crank angle graph 3
Cyele graph 3
Mumeric analysis data items
3D graph

Axis range

Display channels 3
Cycles

Graph colors

Measured Data: Opens a window displaying a crank angle graph of raw data and
corrected data.
Crank angle graph: Opens a window displaying a crank angle graph of calculated
analysis items.

Cycle graph: Opens a window displaying a cycle graph of calculated analysis items.
Numeric Analysis Data Items: Opens a window displaying numeric analysis results

from calculated analysis items.

3D graph: Displays the graph dimension setting screen. Select 2 or 3 dimensions,
and select 3-dimensional graph setting conditions (when the crank angle graph or 3-
dimensional analysis graph is displayed).

The range of cycles extracted from the raw data is set as the maximum range, crank
angle data is extracted every number of cycles specified by “by,” and the data is
displayed in a 3D graph.

Graph Dimension Settings ﬂ
* 20

3

Range of Cyclesl 1 ::II = I 137 ﬁ bvl & ﬁ

Cancel |

Axis range: Displays the graph axes setting screen. You can set a fixed value for the

X and Y axes, or choose Autoscale. These settings are entered for each graph.

Axis Settings =

Woaxiz (% AutoScale : Ok

Range ¢ Manual | 38000 = - | 38000 = o |
ancel

Yoaxiz (% AutoScale

Range ¢ Manual  [-180000 = - [5275.000 =

Display channels: Displays a pull-down menu for display channels. This setting is
entered for each graph.

IM 707766-61E
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3.1 Common Operations

* Cycles: Displays a setting screen for the displayed cycles. These settings are
entered for each graph.

Displayed Cycles ﬂ

& AVE
ALl

B ¢ |
covm | e |

AVE: Displays a cycle average crank angle graph
ALL: Displays superimposed crank angle graphs of all cycles
Other: Displays a crank angle graph of the specified cycles
» Graph colors: Displays the graph color setting screen. These settings are entered
for each graph.
x
|— Background | . Gicd |
B > |l o |
. Graph | CH1 A

OK Cancel |

Basic colors:

(ol ((mfl (1[I
Il |
Wil 0 Wl § |
el 000l
EEEEEEE.
W Wl el |

LCustom colors:

N o o o o
N o o o o

Define Customn Colors »» |

Cancel |

Moving the Cursor

Values can be read in directly using cursors. If you click in a window displaying a graph,
the cursor (a vertical bar) jumps to the point where the mouse was clicked, and the X
and Y axes of that point are displayed. Also, the following buttons can be used to move
the cursor to the right or left in units of the angular resolution.

4 : Fast left cursor

q : Left cursor
> : Right cursor
[

. Fast right cursor

Displaying the Mouse Pointer Position
When the mouse is moved over a graph, the X and Y value of the current position is

displayed on the graph.
Saving Results to a BMP File

Press the | §§ button to save a bit map image of the active graph window.

Displaying Help Information
You can display the user's manual in PDF format. You can also choose About ECP to
display version information about the program.
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3.2 File > Load Measured Data

open 2| ]
Lookjn:l_}SampIe j o =k B Ma. of Strokes: ( 2-cycle (% decycle
demot wf Mo. of effective cycles: I a
Start cycle:
End cycle:
Angular *10ca  05CA

Resoltior: ™ g2sca 01 CA

Messuring  {+ DL70SE " DL716

File name: | Open I Instrument:  pL7so  { wwETOOO
Files of tpe:  [wAvF File[wvf] =l Cancel |

Functions
* You can select a measured data file to be loaded.
Filters can be applied according to the filter settings.
« Set the following for the data to be loaded:
¢ Number of strokes
* Range of cycles to be analyzed
¢ Crank angle resolution
¢ Model of measuring instrument
« If the measuring instrument is incorrect, a warning message is displayed.

suonesadQ pue suseIds H

Setting/Display Data

No. Item Default Setting Data Size Numerical Data Input (1) or
Type Min. Value Max. Value Select (S)

1 No. of Strokes Prev. value - - - - S

2 No. of effective cycles Prev. value | 5.0 1 25000 N.A.

3  Startcycle 1 | 5.0 1 25000 |

4 End cycle Number of effective cycles | 50 1 25000 |

5  Angular Resolution 1.0CA - - - - S

6  Measuring Instrument DL716 - - - - S

(1) No. of effective cycles: When selecting the file to be loaded, the angular
resolution is assumed to be 1 CA, and the number of effective cycles is
calculated using the equation below. If the angular resolution is changed to 0.5,
0.25, or 0.1, the number of effective cycles is updated accordingly.

(portion before the decimal (no. of measured data / no. of data per cycle)) - 3

The maximum number of effective cycles varies depending on the angular
resolution as follows.
e For1CA: 25000 cycles
e For 0.5 CA: 12500 cycles
« For 0.25 CA: 6250 cycles
e For 0.1 CA: 2500 cycles

(2) Start cycle, End cycle: Enter the range of cycles to be analyzed (up to 800
cycles). You cannot enter a value greater than the number of effective cycles
for the data under analysis.

(3) Angular Resolution: Select 1, 0.5, 0.25, or 0.1 according to the conditions
during measurement.
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3-4

3.2 File > Load Measured Data

(4) Measuring Instrument: When loading files, the appropriate instrument is

automatically selected. You can also change the instrument to the DL708E,
DL716, DL750, or WE7000.

Button Operations
Open Button

Selects the start and end cycles and advances to the raw data display screen.
If the number of start/end cycles selected exceeds the maximum number of cycles of
the data to be analyzed, a message is displayed.

x|

[} The range defined by the start cycle and end cycle settings exceeds the number of effective cycles, Reenter the
e 4 walues,

Cancel Button

Clears all screen settings and closes the screen.
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|3.3 File > Save Analysis Data

Save Analysis Data =

Test Date | 0001 06

Drata Mame I

Testing Personnel

Department

Test Mame I

Engine maodel

Serial no.

Place of Test

Test Bench

Comments

[~ Start cycle I 1 End cycle 137
Functions

« Test information can be entered and combustion pressure analysis results can be
saved to a file in CSV format.

Setting/Display Data

No. Item Default Setting Data Size Numerical Data Input () or
Type Min. Value Max. Value Select (S)

1 Data Name Prev. value C - - |

2  Testing Personnel Prev. value C - - |

3  Department Prev. value C 16 - - |

4  Test Name Prev. value C 32 - - |

5 Engine model Prev. value C 16 - - |

6  Serial No. Prev. value C 16 - - |

7  Place of Test Prev. value C 16 - - |

8 Test Bench Prev. value C 16 - - |

9 Comments Prev. value C 32 - - |

10 Start cycle, End cycle Prev. value | 5.0 1 25000 lor S

(1) Start cycle, End cycle: To save a specified range of cycles of crank angle
graph data from the analysis results to a CSV file, choose this command, then
enter the range of cycles to be saved. The suffix “-all” is added to the specified
file name. For example, if you hame the file Sample, the actual file name will
change to Sample-all.csv when saved.

Button Operations

Cancel Button

Clears all screen settings and closes the window.

Save Button

Displays a window allowing you to specify the save location. Clicking OK in that
window saves combustion pressure analysis results data to a text file in CSV format.
Raw data cannot be saved.

IM 707766-61E
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3.4 File >Load Analysis Conditions

open 2%

Look jn: I ) Sample j - = EB-

File name: Idemo‘l .Bcp DOpen I
Files of type:  |ECP File[* ecp] | Cancel |

4

Functions

» Loads analysis conditions (TDC correction value, Number of cylinders, interval of
absolute pressure correction, coefficients for conversion to physical values (calibration
factors), filter setting conditions, calculation parameters, calculation execution items,
analysis graph display conditions, screen layout), and places them into effect as the
current conditions. However, when choosing this command, all previously calculated
results are cleared, and any currently displayed analysis results windows are closed.
Display analysis results windows again after calculations have been performed.
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3.5 File > Save Analysis Conditions

savens 21
Save ir: I ) Sample j - = EB-
demol.ecp

File name: | Save I
Save as type: IEEP File[*.ecp) j Cancel |

4

Functions

« Saves analysis conditions (TDC correction value, Number of cylinders, interval of
absolute pressure correction, coefficients for conversion to physical values (calibration
factors), filter setting conditions, calculation parameters, calculation execution items,
analysis graph display conditions, screen layout).

IM 707766-61E 3-7
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3.6

File > Start Monitor Functions

seten x|
Mumber of Strokes: (0 Zooyele O dooyele
% WETO00
Communication Interface Measuring station IStatiom |
r
- x;gg:m;g:; Measuring module WET2TS <
% Ethernet Slot no. |1 vl = |1 vl
PC-IP address
et Mask
Port no. Rkl
Group no. o
" DL7s0
& Ethernet " sE
DL750 P address 999.999.993.999 DL750 USE 1D I 1
User name ANONYMaUS
Pazsword
OK I Cancel |
Functions

* Sets the communication interface for the PC, and WE7000 as well as the selected
measurement module and slot number.
e Sets the conditions for connection with the DL750.
» Displays the raw data display window.
* You can perform real time monitoring while running the engine combustion analysis
package.

Setting/Display Data

No. Item Default Setting Data Size Numerical Data Input (1) or
Type Min. Value Max. Value Select (S)
1  Number of Strokes Prev. value - - - - S
2 WE7000/DL750 Prev. value - - - - S
3 Communication Interface Prev. value - - - - S
4  PC-IP address Prev. value C 16 - - |
5  Net Mask Prev. value C 16 - - |
6  Portno. Prev. value C 5 1 64000 |
7  Measuring station Prev. value C 16 - - |
8  Measuring module Prev. value - - - - S
9 Slot no. Prev. value - - - - S
10 Ethernet/USB Prev. value - - - - S
11 DL750 IP address Prev. value C 16 - - |
12 User name Prev. value C 16 - - |
13 Password Prev. value C 16 - - |
14 DL750 USB ID Prev. value C 3 - - |
(1) Number of Strokes: Select a 2- or 4-cycle engine
(2) WE7000/DL750: Select the WE7000 or DL750 for the measuring instrument.
(3) Communication Interface (WE7000): Select Optical/Ethernet.
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3.6 File > Start Monitor Functions

4

®)
©)

™
®
©
(10)

(11)

12)

PC-IP address/Net Mask/Port no.: If Ethernet is selected for the
communication interface, enter the IP address, net mask, and port number of
the PC. If the PC has only one network interface, the IP address and net mask
will be automatically assigned if you leave these fields blank.

Measuring station: Enter the WE7000 station name.

Measuring module: Select the WE7235, WE7245, WE7271/WE7272, or
WE7275.

Slot no.: Select the number of installed slots. A range is indicated when
multiple modules are used. When one module is used, enter the same number
into both boxes.

Ethernet/USB (DL750): Select Ethernet/USB.

DL750 IP address: Enter the IP address for the DL750.

User name: Enter the user name for connecting with the DL750.

Password: Enter the password for connecting with the DL750. When the user
name is anonymous, no password is required.

DL750 USB ID: Enter the USB ID of the instrument in the range from 1 to 127.

Button Operations

OK Button
Activates the settings entered in the screen, opens a connection with the measuring
instrument, and closes the window.

Cancel Button
Clears all on-screen settings, and closes the window.

IM 707766-61E
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3.7 File > Close

Functions
» All windows accessing the data files used for the current window are closed.
* The current analysis results are not saved.

3-10 IM 707766-61E



3.8 View > Measured Data

5 Raw data (¥) - demol [1-137Cycle 1CA] 10l =|

5.000

/

_____________ ,E Corrected data (¥) - demol [1-137Cycle 1CA] - |EI|1|

5.000

_____________ m

Current CH
CH1

Current Cyele
2

Filter

LFF

+1.800 i i i i i i i
-360.00 Current CH i i i i i i i
CH1
Current Cycle \
2 I N
Fitter
LPF 4 oao
-360.00 .00 360.00
Crank Ancle (CA)
H-axiz -axis
vaue: | 5000 e DG
Functions

Filters are applied to raw data according to the filter settings, and a crank angle graph
is displayed.

The following are displayed depending on the command used.

View > Measured data > Raw data: Raw data before TDC correction

View > Measured data > Corrected data: Raw data after TDC correction

The data name, cycle range, and angular resolution is displayed in the title bar of the
window.

Shows the displayed channels, displayed cycles, and the current filter settings.

When filter settings are entered, the display is updated.

IM 707766-61E
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3.9 View > Crank Angle Graph

IE Corrected data (¥) - demol [1-137Cycle 1CA] - |EI|1|

5.000

Currert CH ; ; ; ; ; ; ;
CH1
Current Cycle \
2 I N
Fitter
PP 1 oon
-360.00 .00 360.00
Crank Angle (CA)
H-axiz -axis
vaue: | 5000 e DG
Functions

» Displays a crank angle graph of the combustion pressure analysis results.

* The selected values from the cycle graph data items and the measurement items set
to Use in Calculations in the Parameter Settings screen are displayed in the lower
right portion of the screen.

The following shows how the displayed contents varies depending on the settings for
displayed channels and displayed cycles (see section 3.1, “Common Operations”).

Display Channels Cycles Displayed Value
Specified channel Specified cycle Value for specified cycles
AVE Same values as in the numeric analysis data item
screen
ALL None
ALL - None
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3.9 View > Crank Angle Graph

If you select “3D” on the Graph Dimension Settings screen (see section 3.1, “Common
Operations”), the following 3D display appears.

IE Cylinder pressure (kPa} - Crank angle graph - demol [1-137Cycle 1 - |EI|1|

9865.000

/s

-,

-230.000 - -
-360.00 360.00

Functions

» Crank angle display data is extracted each number of specified cycles from the
specified range of cycles, and a 3D graph is displayed.

* The maximum number of cycles that can be displayed is 20.

Setting/Display Data

No. Item Default Setting Data Size Numerical Data Input (1) or
Type Min. Value Max. Value Select (S)
1 Range of Cycles Extracted cycles I 3 1 800 |

IM 707766-61E 3-13
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3.10 View > Cycle Graph

IMaximum cylinder pressure (kPa)

valle :

valle :

7 Maximum cylinder pressure (kPa) - Cycle graph - demol [1-137Cycle 10l =|
7000.000
A A A st e
TR (A G L M W
Currert CH
CH1
Current Cycle
AYE
Fitter
- 3000.000
1.00 137.00
Cyele
~|[sossmenerons Lo To0 % Mgea o

Functions
Displays a cycle graph of the combustion pressure analysis results.
The average values (the same values displayed in the numeric analysis data items

screen) of the selected cycle graph data items and the measurement items set to Use
in Calculations in the Parameter Settings screen are displayed in the lower part of the

screen.
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3.11 View > Numeric Analysis Data ltems

Mumeric analysis data items - demol [1-137Cycle - |EI|1|
ttem | Walue
Piston displacement (m3) 1.007352e-003

Averaged maximum cylinder pressure... 5.035345e+003
Averaged maximum rate of cylinder pr... 1 276950e+002
Averaged NMEP of all cycles and cylin... 1.022580e+003
Averaged IMEP of all cycles and cylin...  1.237354e+003
Averaged PMEP of all cycles and cylin...  -2.147739e+002
Minimum IMEP of all cycles and cylinde... 1.176703e+003

w

LMY of IMEP of all cycles and cylinde... 9.509534e+001 wn
e
[0
[}
tem Pl I S
Averaged cylinder pressure across o -5.875379e+002 o
Averaged maximum cylinder pressure... 5.035345e+003 g
Standard devistion of maximum cylind...  2.555109e+002 o
Rate of change in maximum cylinder p...  5.074347e+000 o
Averaged maximum rate of cylinder pr... 1 276950e+002 o
Standard deviation of maxdimum rate of ... 2.044104e+001 Q
Rate of change in maximum rate of cyl... 1 B00771e+001 a
Averaged MMEP (kPa) 1.022560e+003 6
Standard devistion of MMEP (kPa) 1.997706e+001 =
Rate of change in MMEP (36) 1.9535585e+000 [}
Averaged IMEP (kPa) 1.237354e+003 l
] | o
Functions

« Displays the numeric analysis data items of the combustion pressure analysis results.
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3.12 Settings > Filter

Filter Setting =

" Mone

* Lowpass

(" Bandpass

{~ Highpass

720

Cancel |

Functions

You can perform digital filter processing on raw data. If the raw or corrected data has
already been displayed, filters are automatically applied and the display is updated.
However, this does not affect current analysis results. All calculated results are
cleared, and any currently displayed analysis results windows are closed. Display
analysis results windows again after calculations have been performed.

You can select None, Lowpass, Bandpass, or Highpass filters.

The filter function is a 4th order Butterworth (24 db/oct).

The cutoff frequency is set in numbers of orders (multiples) since data acquisition
uses synchronization with the rotation pulse.

When filters are applied, any TDC correction and combustion pressure analysis
performed thereafter is done on filtered data.

Setting/Display Data

No. Item Default Setting Data Size Numerical Data Input (1) or
Type Min. Value Max. Value Select (S)

1  Filter type Prev. value - - - - S

2 Cutoff Prev. value F 6.1 7.2 720 |

(1) Filter type Select None, Lowpass, Bandpass, or Highpass for the filter.

(2) Cutoff: The cutoff can be set in the following ranges:
At 1 CA resolution, 7.2 order (times) to 72 order (times) of the number of
revolutions
At 0.5 CA resolution, 14.4 order (times) to 144 order (times) of the number of
revolutions
At 0.25 CA resolution, 28.8 order (times) to 288 order (times) of the number of
revolutions
At 0.1 CA resolution, 72 order (times) to 720 order (times) of the number of
revolutions

Button Operations
OK Button

Activates filters conditions, applies filters to raw data, and closes the window.

Cancel Button

Clears all on-screen settings, and closes the window.
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3.13 Settings > TDC Correction and Calibration
Factor Settings

TDC Correction and Calibration Factor Setting - demol =
—TDC Caorrection —Conditions by Channel
Interval of Ahsolute
Calculate | Pressure Correction
Channel Starting Encling
) Unused o B
TDC Correction Mame angle angle
and Calioration I 3000 ca CHI ™ [P1kpa) ~|| -1soo0 [ -17eo0 | 100000 .y, 0.00 3
Factor Sefting —
CH2 [ [ other-) - 000 000 | 100000 sy, 0.00
gm‘iﬁgf m CH3 [ [ other-) =l oo _ | 000 | 100000 ay | 0.00 (r/))
CHa ™ | atheri-) j| 000 | 0.00 | 1000.00 *x+| 0.00 o
%E"gder";jcy"”der cHs ™ [ other(-) = 000 000 [ 100000 .y, 0.00 g
Orrection —_—
l— CHE [ [ other-) - 0.00 000 | 100000 » 0.00 n
P 3000 ca I 0 ! 00 s . o
2500 CHZ ™ | atheri-) j| 000 | 0.00 | 1000.00 *x+| 0.00 S_
P2 00 ca
w500 CHE ™ | atheri-) j| 000 | 0.00 | 1000.00 *x+| 0.00 o
P3 00 ca
w0 CHE [ [ other-) - 000 000 | 100000 sy, 0.00 '8
P4 00 ca —
Mmoo CHI0 [~ [ atheri-) - 000 000 | 100000 sy, 0.00 o
P5 00 |ca — =
w500 CHIT I | ather) j| 000 | 0.00 | 1000.00 *x+| 0.00 o
P 00 ca =
w500 CHIZ ™ | atheri-) j| 000 | 0.00 | 1000.00 *x+| 0.00 %)
7 00 ca
CH13 [~ [ atheri-) - 0.00 000 | 100000 » 0.00
oo | 00 sy |
p3| 4900 cp I
CH14 [~ [ ather(-) - 000 000 | 100000 sy, 0.00
CHIS ™ | atheri-) j| 000 | 0.00 | 1000.00 *x+| 0.00
CHIE ™ | atheri-) j| 000 | 0.00 | 1000.00 *x+| 0.00
Cancel |

Functions

The TDC correction value can be calculated using one cycle’s worth of all-cycle-
averaged motoring data from cylinder 1 (P1).

The calculated TDC correction value is added to the difference in angle between
cylinders according to the specified number of cylinders (for example at 4 cycles and
4 cylinders) in the following manner: 0 + calculated TDC correction value, 180 +
calculated TDC correction value, 360 + calculated TDC correction value, 540 +
calculated TDC correction value, then the cylinder-to-cylinder TDC correction value is
automatically set.

You can also set the cylinder-to-cylinder TDC correction values manually (excluding
P1).

Signal assignments can be entered.

You can assign channels to cylinder pressure (up to eight cylinder's worth), intake
manifold pressure, intake manifold temperature, fuel consumption, rpm, exhaust gas
pressure, exhaust gas temperature, supercharger inlet pressure, supercharger inlet
temperature, and other signals.

The cylinder pressure signals undergo TDC correction per the specified TDC
correction value.

Cylinder pressure measurements take place in the cylinder’s firing order, with the
assumption that all signals are assigned to contiguous channels starting with channel
1.

You can specify channels to be excluded from combustion pressure analysis.

If the raw or corrected data has already been displayed, settings are automatically
applied and the display is updated. However, this does not affect current analysis
results. When changing these settings, all previously calculated results are cleared,
and any currently displayed analysis results windows are closed. Display analysis
results windows again after calculations have been performed.

IM 707766-61E
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3.13 Settings > TDC Correction and Calibration Factor Settings

Setting/Display Data

No. Item Default Setting Data Size Numerical Data Input (1) or
Type Min. Value Max. Value Select (S)

Calculated TDC Correction Value  Calculated value F 7.2 (*1) (*2) |
Number of Cylinders Prev. value | 2.0 1 8 S
Cylinder-to-cylinder Calculated value F 72  (*1) (*3) |
TDC Correction
Unused None - - - - S
Channel Name None - - - - S
Interval of Absolute Pressure Prev. value F 72  (*1) (*2) |
Correction

7 A Prev. value F 8.2 99999.99 |

8 B Prev. value F 8.2 99999.99 |

*1: 4 cycles = -360; 2 cycles = -180
*2:4 cycles = -359.9; 2 cycles = -179.9
*3: 4 cycles = -1079.9; 2 cycles = -539.9

@

@)

®)

(4)

®)

(6)

Calculated TDC Correction Valudisplays the TDC correction values
calculated using the average of all cycles of the first cylinder (P1). The value
can also be entered manually. When the OK button is used, this value is
rounded to the angular resolution and applied to each channel.
Number of Cylinders: Specified for automatic calculation of the cylinder-to-
cylinder correction value. If the value is changed, click the Calculate button to
recalculate the results.
Cylinder-to-cylinder TDC Correction: The calculated TDC correction value is
added to the difference in the crank angle. For example, with a 4-cycle engine:
4 cylinders = 180 CA, 6 cylinders = 120 CA, and 8 cylinders = 90 CA. You can
also set the value manually (excluding P1).
Unused: Selected channels are ignored during analysis. CSV files are also not
saved.
Channel Names: Signals are assigned to channels 1 through 16. Select the
signal type from the options below.

P1 to P8: Cylinder pressure in the order of firing

Pitk: Intake manifold pressure
Gfuel: Fuel consumption
Ne: Revolutions per minute
Td: Intake manifold temperature
Pex: Exhaust gas pressure
Tex: Exhaust gas temperature
Pturbin:  Supercharger inlet pressure
Tturbin:  Supercharger inlet temperature
Other: Other Signals
For signals other than P1 through P8, TDC correction is performed based on the
1st cylinder.

This measured data can be used when measuring intake manifold pressure, fuel
consumption, revolutions per minute, and intake manifold temperature, and
performing analysis. The average value at each cycle can be saved to a .csv
file.

Other signals can be displayed in a crank angle graph or cycle graph, and that
graphical data can be saved in CSV format.

A, B: The measured voltage signals are converted to physical values using the
equationy = Ax + B.

3-18

IM 707766-61E



3.13 Settings > TDC and Calibration Factor Settings

Button Operations
OK Button

Activates all on-screen settings, and closes the window.
Cancel Button

Clears all on-screen settings, and closes the window.
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3.14 Calculation > Set Parameters

Parameter Settings - demol.wvf =

Cor-rod length [ 1e0.000 i & Fuel consumption lm .

Bore 110.000 i € Weasured fuel cousumption

Piston offset 0.000 i Mumber of eylinders I 1

Stroke 108.000 \n Low hest valus 49372000 JiKg

Pl e 1.000 Gas constant 29.270

& Clearance volume E2960  ns Suction volumetric efficiency 80000 g

" Compression ratio W Specific gravity 0800 | gicm3

& without supercharging Cylinder head wall temperature | 200.000  deg

" ith supercharging l— Cylinder wall temperature 200000 degC
Bootiies e 0000 | kpa Piston head wall temperature 200000 degC

* Supercharger inlet pressure

| 102.000  kpa

 Weazured supercharger inlet pressure

[ 102000 45y

€ Weazured exhaust OEE pressure

& ) I—
% ST N EERTE 30000 9e8C 13 Exhaust gas temperature 550,000 deglC

 Weazured supercharger inlet temperature
€ Weazured exhaust oas temperature

| 1200 rpm

 Weazured revolutions REr minute

& Atmospheric temperature I 25000 gege

' Exhaust &S pressure

Bioost tempersture 30.000  degc

' Revolutions per minute

" Presence of heat loss processing
' pbsence of hest loss processing

('\- . " el

Szt (PEl cornbustlon. . 000 caA ¢ Measured intake manifold temperature
o Mumber of data tems for judging —5

start point of combustion o Atmospheric pressure I 102404 oo
" End point of combustion I 000 cp = Messured intske manitald pressure

. Mumber of data tems for judging
end point of combustion

—

‘Windowy for searching maximum rate of heat releasze

' Absolute pressure correction for each cycle
& ppsolute pressure correction for cycle average

| 36000 - | 35900 ca
Ratio for judging angle of l—
combustion mazss rate M1 |

Ratio for judging angle of
combustion mazss rate M2
Ratio for judging angle of
combustion mass rate N3

[ 50 %
[ E

100000 e Ok

Cancel

“alue for judging misfire I

Functions

Lets you enter necessary engine and other parameters for combustion pressure
analysis.

You can select either Clearance volume or Compression ratio.

Enter the number of data from which to determine the start and end of combustion.
Or, enter the combustion start and end values directly.

Specify the range for searching for the maximum rate of heat release.

Select the method of absolute pressure correction.

Select whether or not to use this measured data for analysis when measuring intake
manifold pressure, fuel consumption, revolutions per minute, intake manifold
temperature, exhaust gas pressure, exhaust gas temperature, supercharger inlet
pressure, and supercharger inlet temperature.

When changing these settings, all previously calculated results are cleared, and any
currently displayed analysis results windows are closed. Display analysis results
windows again after calculations have been performed.
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3.14 Calculation > Set Parameters

Setting/Display Data

No. Item Unit  Default Setting Data Size Numerical Data Input (1) or
Type Min. Value Max. Value Select (S)

1 Con-rod Length mm Prev. value F 9.3 0.000 99999.999 |

2 Bore mm Prev. value F 9.3 0.000 99999.999 |

3 Piston offset mm Prev. value F 9.3  0.000 99999.999 |

4 Stroke mm Prev. value F 9.3 0.000 99999.999 |

5 Piston head ratio - Prev. value F 9.3  0.000 99999.999 |

6  Clearance volume cm?® Prev. value F 9.3 0.000 99999.999 lorS

7  Compression ratio - Prev. value F 6.3 0.000 99.999 lorS

8  With/Without - Prev. value - - - - S
supercharging

9  Boost pressure kPa Prev. value 9.3 0.000 99999.999 lorS

10 Supercharger inlet pressure kPa  Prev. value 9.3  0.000 99999.999 lorS

11 Measured supercharger - - - - - - S
inlet pressure

12 Supercharger inlet °C Prev. value F 9.3 -273.000 99999.999 lorS
temperature

13 Measured supercharger - - - - - - S
inlet temperature

14 Boost temperature °C Prev. value F 9.3 -273.000 99999.999 lorS

15 Presence/absence of heat - - - - - - S
loss processing

16 Start point of combustion  CA Prev. value F 6.2 -360.00 359.99 |

17 Number of data items for - Prev. value | 2.0 3 99 |
judging start point of
combustion

18 End point of combustion CA Prev. value F 6.2 -360.00 359.99 |

19 Number of data items for - Prev. value | 2.0 3 99 |
judging end point of
combustion

20 Window of searching CA Prev. value F 6.2 -360.00 359.99 |
maximum rate of heat
release

21 Ratio for judging angle % Prev. value | 20 5 95 |
of combustion mass rate

22 Value for judging misfire kPa Prev. value F 9.3 0.000 99999.999 |

23 Fuel consumption cm®/s Prev. value 9.3 0.000 99999.999 lorS

24 Measured fuel consumption - - - - - - S

25 Number of cylinders - Prev. value | 1.0 1 8 lorS

26 Low heat value J/kg  Prev. value | 9 0 999999999 |

27 Gas constant - Prev. value F 9.3 0.000 99999.999 |
(x9.80665 J/kg.K)

28 Suction volumetric efficiency % Prev. value 9.3 0.000 99999.999 |

29 Specific gravity - Prev. value 9.3 0.000 99999.999 |

30 Cylinder head wall °C Prev. value F 9.3  0.000 99999.999 |
temperature

31 Cylinder wall temperature  °C Prev. value 9.3 0.000 99999.999 |

32 Piston head wall °C Prev. value F 9.3  0.000 99999.999 |
temperature

33 Exhaust gas pressure kPa Prev. value F 9.3 0.000 99999.999 |

34 Measured exhaust gas - - - - - - S
pressure

35 Exhaust gas temperature  °C Prev. value F 9.3 0.000 99999.999 |
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3.14 Calculation > Set Parameters

No.

Item

Unit

Default Setting Data Size Numerical Data Input (1) or

Type Min. Value Max. Value Select (S)

36

Measured exhaust gas
temperature

- - - - - s

37

Revolutions per minute

rpm

Prev. value | 50 O 99999 lorS

38

Measured revolutions
per minute

- - - - - s

39

Atmospheric temperature

°C

Prev. value F 9.3 -273.000 99999.999 lorS

40

Measured intake manifold
temperature

- - - - - S

41

Atmospheric pressure

kPa

Prev. value F 9.3  0.000 99999.999 lorS

42

Measured intake manifold
pressure

- - - - - S

43

Method of absolute
pressure correction

@
@
©)

4

®)

6

®)

)

©

(10)

(11)

Start point of combustion: The specified value (without searching).

End point of combustion: The specified value (without searching).

Window of searching maximum rate of heat release: Set the range for
finding the maximum angle of the rate of heat release used as the standard for
searching for the start and end points of combustion.

Ratio for judging angle of combustion mass rate: Determines the crank
angle at which the combustion mass rate matches the specified percentage.
Value for judging misfire: Cycles for which the IMEP is lower than this setting
are judged as misfires, and the rate of misfire is determined by the ratio of the
number of misfiring cycles relative to the total number of cycles.

Measured fuel consumption and Number of cylinders: Measures the fuel
consumption, and when using the result for calculations, you can select this item
or specify how many cylinders worth of fuel consumption it represents. In the
TDC Correction and Calibration Factor Setting screen, it is assumed that fuel
consumption (Gfuel) is assigned to a channel.

Measured exhaust gas pressure: Select this item when measuring the
pressure of exhaust gas and using the result for calculations. In the TDC
Correction and Calibration Factor Setting screen, it is assumed that exhaust gas
pressure (Pex) is assigned to a channel.

Measured exhaust gas temperature: Select this item when measuring the
temperature of exhaust gas and using the result for calculations. In the TDC
Correction and Calibration Factor Setting screen, it is assumed that exhaust gas
temperature (Tex) is assigned to a channel.

Measured revolutions per minute: Select this item when measuring rpm's and
using the result for calculations. In the TDC Correction and Calibration Factor
Setting screen, it is assumed that rpm (Ne) is assigned to a channel.

Measured intake manifold temperature: Select this item when measuring the
temperature of the intake manifold and using the result for calculations. In the
TDC Correction and Calibration Factor Setting screen, it is assumed that fuel
consumption(Td) is assigned to a channel.

Measured intake manifold pressure: Select this item when measuring the
pressure in the intake manifold and using the result for calculations. In the TDC
Correction and Calibration Factor Setting screen, it is assumed that intake
manifold pressure (Pitk) is assigned to a channel.
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3.14 Calculation > Set Parameters

Button Operations

OK Button
Activates all on-screen settings and closes the window. The settings take effect for
the next calculation.

Cancel Button
Clears all on-screen settings, and closes the window.

IM 707766-61E
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3.15 Calculation > Calculate

Calculation

== Data item for cylinder pressure analysis ==
™ Cylinder pressure (kPa)

¥ Rate of cylinder pressure rize (kPaideg)
¥ Amourt of heat release )]

¥ Rate of hest release [Jiclec)

¥ Combustion mass rate (%)

v Cylinder gas tempersture (degC)

v Cylinder pressure (kPa)

v Logarithmic cylinder pressure (kPa)

v Polytropic index

¥ Other signals

== Diata item for transient analysis ==

¥ Maximum cylinder pressure (kPa)

v Angle st maximum cylinder pressure (T4
IV mazimum rate of cylinder pressure rise (kPasded)

[+ MMEP (kP=)

v Angle st maximum amount of hest release (C4)
[¥ aximum amount of hest release )]

v Angle at maximum rate of heat release (CA)
¥ Maximum rate of hest release [Jiclec)

¥ Other signals

v Angle at maximum rate of cylinder pressure rise (C4) ©

- Crank angle graph
- Crank angle graph
- Crank angle graph
- Crank angle graph
- Crank angle graph
- Crank angle graph
- Piston displacement graph
- Logarithmic piston
displacement graph
- Crank angle graph
- Crank angle graph

- Cycle graph
- Cycle graph
- Cycle graph
Cyele graph
- Cycle graph
- Cycle graph
- Cycle graph
- Cycle graph
- Cycle graph
- Cycle graph

Select Al |

Functions

* You can select items to undergo combustion pressure analysis, then execute the
analysis. Cylinder pressure and rate of cylinder pressure rise are always analyzed.

* The progress of the combustion pressure calculation is shown by the filling in of each
check box. If a particular calculation is impossible, the item is skipped and the

software advances to the next item.

Button Operations
Calculate Button:

Calculates the selected analysis items (including related calculations).

Close Button:

This button appears when calculation ends. Closes the window.

Cancel Button

This button disappears when calculation is started.

Closes the window.
Stop Button
Stops calculation.
Select All Button
Selects all items for analysis.
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3.16 Graph

Functions

» These are the same functions as the ones described in section 3.1, “Common
Operations:”
They include graph dimension settings, axis settings, displayed channels, displayed
cycles, and graph color settings.

IM 707766-61E
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3.17 Window > Cascade

Functions
» Arranges all open windows in a cascading fashion.
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3.18 Window > Tile

Functions
« Arranges all open windows in a non-overlapping fashion.

IM 707766-61E
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|3.19 Window > Arrange Icons

Functions
* Arranges minimized icons.
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3.20 Window > Minimize

Functions
* Minimizes all windows accessing the same data.
¢ Minimizes all monitor function windows.

IM 707766-61E
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3.21 Window > Restore

Functions
« Restores all minimized windows that were accessing the same data.
¢ Restores all minimized monitor function windows.
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Chapter 4 CSV Files

4.1

Saved Iltems

Test Information, Manually Input Data Iltems

Test Information
Test date

Data name
Testing personnel
Department

Test name
Engine type
Serial No.

Place of test
Test bench type
Comments

Manually Input Data Items

Calculated TDC correction value (CA)

Number of cylinders

Channel-by-channel TDC correction value (CA)
Channel-by-channel calibration factor A (kPa/V)
Channel-by-channel calibration factor B (kPa/V)
Channel-by-channel used/unused (1: Used)

Starting angle of correction interval (CA)

Ending angle of correction interval (CA)

Channel name

Con-rod length (m)

Bore (m)

Piston offset (m)

Stroke length (m)

Piston head ratio

Clearance volume (m®)

Compression ratio

Presence/absence of supercharging

Supercharger inlet pressure (kPa)

Supercharger inlet temperature (°C)

Boost temperature (°C)

Presence/absence of heat loss processing

Angle for start point of combustion (point a) (CA)

Number of data items for judging start point of combustion
Angle for end point of combustion (point b) (CA)

Number of data items for judging end point of combustion
Start point of searching maximum rate of heat release (CA)
End point of searching maximum rate of heat release (CA)
Ratio for judging angle of combustion mass rate N1 (%)
Ratio for judging angle of combustion mass rate N2 (%)
Ratio for judging angle of combustion mass rate N3 (%)
Value for judging misfire (kPa)

Fuel consumption (m®/s)

Number of cylinders (used to calculate fuel consumption)
Heat release at lowest position (J/kg)

Gas constant (x9.80665 J/kg.K)
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4.1

Saved Items

Calculation Results

Suction volumetric efficiency (%)
Specific gravity

Cylinder head wall temperature (°C)
Cylinder wall temperature (°C)
Piston head wall temperature (°C)
Exhaust gas pressure (kPa)
Exhaust gas temperature (°C)
Revolutions per minute (rpm)
Atmospheric temperature (°C)
Atmospheric pressure (kPa)
Method of absolute pressure correction

Calculation Data Items: Numeric Analysis Data

Average cylinder pressure across correction interval (kPa)
Averaged maximum cylinder pressure (kPa)

Standard deviation of maximum cylinder pressure (kPa)

Rate of change in maximum cylinder pressure (%)

Averaged maximum rate of cylinder pressure rise (kPa/deg)
Standard deviation of maximum rate of cylinder pressure rise (kPa/deg)
Rate of change in maximum rate of cylinder pressure rise (%)
Piston displacement (m?®)

Averaged NMEP (kPa)

Standard deviation of NMEP (kPa)

Rate of change in NMEP (%)

Averaged IMEP (kPa)

Standard deviation of IMEP (kPa)

Rate of change in IMEP (%)

Averaged PMEP (kPa)

Standard deviation of PMEP (kPa)

Rate of change in PMEP (%)

Averaged maximum cylinder gas temperature (°C)

Standard deviation of maximum cylinder gas temperature (°C)
Rate of change in maximum cylinder gas temperature (%)
Averaged maximum rate of heat release (J/deg)

Standard deviation of maximum rate of heat release (J/deg)
Rate of change in maximum rate of heat release (%)

Averaged maximum amount of heat release (J)

Standard deviation of maximum amount of heat release (J)

Rate of change in maximum amount of heat release (%)
Averaged angle at combustion mass rate N1 % (CA)

Standard deviation of angle at combustion mass rate N1 % (CA)
Rate of change in angle at combustion mass rate N1 % (%)
Averaged angle at combustion mass rate N2 % (CA)

Standard deviation of angle at combustion mass rate N2 % (CA)
Rate of change in angle at combustion mass rate N2 % (%)
Averaged angle at combustion mass rate N3 % (CA)

Standard deviation of angle at combustion mass rate N3 % (CA)
Rate of change in angle at combustion mass rate N3 % (%)
Average start point of combustion (point a) (CA)

Average end point of combustion (point b) (CA)

Minimum value of IMEP (kPa)
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4.1 Saved Items

LNV of IMEP (%)

Rate of misfire (%)

Averaged maximum cylinder pressure of all cycles and cylinders (kPa)
Averaged maximum rate of cylinder pressure rise of all cycles and cylinders (kPa/deg)
Averaged NMEP of all cycles and cylinders (kPa)

Averaged IMEP of all cycles and cylinders (kPa)

Averaged PMEP of all cycles and cylinders (kPa)

Minimum IMEP of all cycles and cylinders (kPa)

LNV of IMEP of all cycles and cylinders (%)

Mass of intake fuel (kg)

Mass of intake air (kg)

Excess air factor

Corrected gas constant

Mass of remaining gas (kg)

Calculation Data Items: Crank Angle Graph Data Items
Crank angle

Average cylinder pressure (kPa)

Logarithmic average cylinder pressure (kPa)
Piston displacement (m)

Piston displacement (m?®)

Average rate of cylinder pressure rise (kPa/deg)
Average cylinder gas temperature (°C)

Average rate of heat release (J/deg)

Average amount of heat release (J)

Average combustion mass rate (%)

Ratio of specific heat

Polytropic index

Rate of heat release (Received heat) (J/deg)
Rate of heat release (Heat loss) (J/deg)

Calculation Data Items: Cycle Graph Data Items

Cycle

Maximum cylinder pressure (kPa)

Crank angle at maximum cylinder pressure (CA)

Averaged maximum cylinder pressure of all cylinders (kPa)

Averaged crank angle at maximum cylinder pressure of all cylinders (CA)
Maximum rate of cylinder pressure rise (kPa/deg)

Crank angle at maximum rate of cylinder pressure rise (CA)

Averaged maximum rate of cylinder pressure rise of all cylinders (kPa/deg)
Averaged angle at maximum rate of cylinder pressure rise of all cylinders (CA)
Compression/expansion work (J)

Pumping loss (J)

NMEP (kPa)

Averaged NMEP of all cylinders (kPa)
IMEP (kPa)

Averaged IMEP of all cylinders (kPa)
PMEP (kPa)

Averaged PMEP of all cylinders (kPa)

Maximum cylinder gas temperature (°C)

Crank angle at maximum cylinder gas temperature (CA)
Maximum rate of heat release (J/deg)
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4.1 Saved Items

Crank angle at maximum rate of heat release (CA)
Maximum amount of heat release (J)

Crank angle at maximum amount of heat release (CA)
Angle at combustion mass rate N1 % (CA)

Angle at combustion mass rate N2 % (CA)

Angle at combustion mass rate N3 % (CA)

Start point of combustion (point a) (CA)

End point of combustion (point b) (CA)

* When carrying out a per-cycle absolute pressure correction, the per-cycle absolute pressure
correction value are left in the Calculation Item: Cycle Graph Data field.

Calculation Data Iltems: Crank Angle Graph Data (Other Signals)
Crank angle

Intake manifold pressure (kPa)

Fuel consumption (cm?/s)

Revolutions per minute (rpm)

Intake manifold temperature (°C)
Exhaust gas pressure (kPa)

Exhaust gas temperature (°C)
Supercharger inlet pressure (kPa)
Supercharger inlet temperature (°C)
Other signals (Crank angle graph data)

Calculation Data Iltems: Cycle Graph Data Iltems (Other Signals)
Cycle

Intake manifold pressure (kPa)

Fuel consumption (cm?/s)
Revolutions per minute (rpm)

Intake manifold temperature (°C)
Exhaust gas pressure (kPa)
Exhaust gas temperature (°C)
Supercharger inlet pressure (kPa)
Supercharger inlet temperature (°C)
Other signals (Cycle data)

4-4
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4.1 Saved Items

Crank Angle Graph Data of Specified Range of Cycles

Crank angle

Cylinder pressure (kPa)

Rate of cylinder pressure rise (kPa/deg)
Cylinder gas temperature (°C)

Rate of heat release (J/deg)

Amount of heat release (J)

Combustion mass rate (%)

Ratio of specific heat

Rate of heat release (Received heat) (J/deg)
Rate of heat release (Heat loss) (J/deg)
Intake manifold pressure (kPa)

Fuel consumption (cm?/s)

Revolutions per minute (rpm)

Intake manifold temperature (°C)
Exhaust gas pressure (kPa)

Exhaust gas temperature (°C)
Supercharger inlet pressure (kPa)
Supercharger inlet temperature (°C)
Other signals (Crank angle graph data)

* Intake manifold pressure, fuel consumption, rpm, intake manifold temperature, exhaust gas

pressure, exhaust gas temperature, supercharger inlet pressure, and supercharger inlet

temperature are saved only when they are measured.
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Chapter 5 Equations

5.1 Explanation of Equations

1. POin

2. Padj[N]

3. Pitk_ave[N]

4. P9 [720, N]

In the explanations below, 720 indicates the angle at cycle 1 for a 4-cycle engine.
Substitute 360 for a 2-cycle engine.

Cylinder pressure (kPa) of the specified range of cycles extracted after rotational offset
correction and TDC correction

PO in= A x U[720,N] + B

N: Number of cycles

u: Voltage value (measured value) of the specified range of cycles
extracted after rotational offset correction and TDC correction (V)

A, B: Sensor calibration factor (kPa/V) (manually input)

Average cylinder pressure (kPa) of the specified crank angle range used for the absolute
pressure correction

For per-cycle average

suonenbg ﬂ

Padj[N] = ave(P6 in[6 = adj 61 to adj 62,N]) # ave: average value
For all-cycle average
Padj[N] = ave(P6 in_ave[6 = adj 61 to adj 62]) # ave: average value
N: Number of cycles
PO in: Cylinder pressure (kPa) (calculated value) of the specified range of

cycles extracted after rotational offset correction and TDC correction
PBin_ave: Average cylinder pressure (kPa) (calculated value)
P8 in_ave[720] = (1 / N) x =(P6 in[720,N])

adj 61: Starting angle (CA) of the range used for absolute pressure correction
(manually input)
adj 62: Ending angle (CA) of the range used for absolute pressure correction

(manually input)

Average intake manifold pressure at each cycle (kPa)

When intake manifold pressure is set to be measured and used in calculations:

Pitk_ave[N] = ave(P#0 itk[720,N]) # ave: average value
N: Number of cycles
PO itk: Intake manifold pressure (kPa) (measured value)

Cylinder pressure after absolute pressure correction (kPa)

* When the atmospheric and boost pressures are manually input,
PO [720,N] = PO in[720, N] — Padj[N] + Pa + Pt

* When depending on the measured intake manifold pressure,
P6 [720,N] = PO in[720,N] — Padj[N] + Pitk_ave [N]

N: Number of cycles

PO in: Cylinder pressure (kPa) after rotational offset correction and TDC
correction (calculated value)

Pad;: Average cylinder pressure across correction interval (kPa) (calculated
value)

Pa: Atmospheric pressure (kPa) (manually input)

pt: Boost pressure (kPa) (manually input)

Pitk_ave: Average intake manifold pressure (kPa) (calculated value)
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5.1 Explanation of Equations

5. logP# [720, N]
Logarithmic cylinder pressure (kPa)

logP® [720,N] = log10(P6 [720,N])

N: Number of cycles
PO : Cylinder pressure (kPa) after absolute pressure correction (calculated
value)

6. P6 ave[720]
Average cylinder pressure (kPa)

PO ave[720] = (1 / N) x Z(PO[720,N])

N: Number of cycles
Po: Cylinder pressure (kPa) after absolute pressure correction (calculated
value)

7. logP6 ave[720]

Logarithmic average cylinder pressure (kPa)

logP6 ave[720] = log10(P6 ave[720])

Po6 ave: Average cylinder pressure (kPa) (calculated value)

8. X0 [720]
Piston displacement (m)

R=S/2
¢ = arcsin(y / (L+R))
X0 [720] = sqrt (R+L)? —y?) — R x cos((0 + o) x (pi / 180) + ¢)

— sgrt(L? — (-R x sin((¢ +a) x (pi / 180) + ¢) + y)?) # sqrt: square root
S: Stroke length (m) (manually input)
L: Con-rod length (m) (manually input)
Y Piston offset (m) (manually input)
0: Crank angle (CA) radian
4-cycle engine: —360 to +359 CA: at 1 CA resolution
2-cycle engine: —180 to +179 CA: at 1 CA resolution
o The numbers to the right of the decimal of the TDC correction value
(CA) (calculated or manually input). In other words, given an angular
resolution of 1 CA, the value is (6 +a) = O+a, 1+a, . . .
pi: The circular constant
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5.1 Explanation of Equations

9. Ve [720]

Piston displacement (m?®)

When Clearance volume is selected on the Parameter Settings screen
Ve [720] = (pi/ 4) x B2 x X0 [720] + Vc

When Compression ratio is selected on the Parameter Settings screen
V6 [720] = (pi / 4) x B2 x X8 [720] + Vst / (Cr-1)

pi: The circular constant

B: Bore (m) (manually input)

X6: Piston displacement (m) (calculated value)
Ve: Clearance volume (m®) (manually input)
Vst: Piston displacement (m®) (calculated value)
Cr: Compression ratio (manually input)

10. dVe [720]
Rate of piston displacement increase (m®/deg)

dVve [720] = (VOn2 — 8 x VOn.1 + 8 x VOn+1 — VOns2) / (12 x res)
When the angular resolution is 1 CA, the calculation is made as shown below.
When n =1 or 2, (VBn-2, VOn.1) = (VO719, PB720) or (VB720, VOoo1)
When n =719 or 720, (VOn+1, VOn+2) = (VO720, VB001) Or (VBoo1, VO002)
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Veo: Piston displacement (m®) (calculated value)
res: Angular resolution (1, 0.5, 0.25, or 0.1 CA)

11. logVe [720]
Logarithmic piston displacement (m?®)

logVe [720] = logo(Ve [720])

Vo : Piston displacement (m®) (calculated value)

12. dP6 [720,N]
Rate of cylinder pressure rise (kPa/deg)

dP8 [720, N] = (PBn-2 — 8 x POn-1 + 8 x POns1 — POn+2) / (12 x res)
When the resolution is 1 CA, the calculation is made as shown below.
When n =1 or 2, (PBn—2, POn-1) = (PBoo1, PBoo1)
When n =719 or 720, (P6n+1, PBn+2) = (PB720, PB720)

N: Number of cycles

Po: Cylinder pressure (kPa) after absolute pressure correction (calculated
value)

res: Angular resolution (1, 0.5, 0.25, or 0.1 CA)

13. dP9 ave [720]

Average rate of cylinder pressure rise (kPa/deg)
dP6 ave[720] = (1 / N) x Z(dP#6 in[720,N])

N : Number of cycles
dpPe : Rate of cylinder pressure rise (kPa/deg) (calculated value)
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5.1 Explanation of Equations

14. Pmax[N]
Maximum cylinder pressure (kPa)
Pmax[N] = max(P6 [720,N]) # max: maximum value
N : Number of cycles
PO : Cylinder pressure (kPa) (calculated value)

15. 6Pmax [N]
Crank angle at maximum cylinder pressure (CA)

6Pmax[N] = pos(P6 [720,N]) # pos: crank angle at max. cylinder pressure
N : Number of cycles
PO : Cylinder pressure (kPa) (calculated value)

16. 6Pmax_ave
Averaged crank angle at maximum cylinder pressure (CA)

OPmax_ave = (1 / N) x Z(6Pmax [N])
N : Number of cycles
6Pmax : Crank angle at maximum cylinder pressure (CA) (calculated value)
17. Pmax_ave
Averaged maximum cylinder pressure (kPa)
Pmax_ave = (1 / N) x Z(Pmax [N])
N : Number of cycles
Pmax : Maximum cylinder pressure (kPa) (calculated value)
18. Pmax_std
Standard deviation of maximum cylinder pressure (kPa)
Pmax_std = sqrt((1 / (N-1)) x Z(Pmax [N] — Pmax_ave)?) # sqrt: square root

N : Number of cycles
Pmax : Maximum cylinder pressure (kPa) (calculated value)
Pmax_ave : Averaged maximum cylinder pressure (kPa) (calculated value)

19. Pmax_cov
Rate of change (%) in maximum cylinder pressure
Pmax_cov = (Pmax_std / Pmax_ave) x 100

Pmax_std : Standard deviation of the max. cylinder pressure (kPa) (calculated
value)
Pmax_ave : Averaged max. cylinder pressure (kPa) (calculated value)

20. Pmax_Cy[N]
Averaged maximum cylinder pressure of all cylinders (kPa)

Pmax_cy[N] = (1 / Cy) x =(Pmax [Cy, N])

Cy: Number of cylinders
N: Number of cycles
Pmax : Maximum cylinder pressure (kPa) (calculated value)
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5.1 Explanation of Equations

21. Pmax_Cy ave
Averaged maximum cylinder pressure of all cycles and cylinders (kPa)

Pmax_Cy_ave = (1/N) x Z(Pmax_Cy [N])

N : Number of cycles
Pmax_Cy: Averaged maximum cylinder pressure of all cylinders (kPa) (calculated
value)

22. 6Pmax_Cy [N]
Averaged crank angle at maximum cylinder pressure of all cylinders (CA)

6Pmax_Cy[N] = (1 / Cy) x Z(6Pmax [Cy, N])

Cy: Number of cylinders
N : Number of cycles
6Pmax : Crank angle at maximum cylinder pressure (CA) (calculated value)

23. 6Pmax_Cy_ave
Averaged crank angle at maximum cylinder pressure of all cycles and cylinders (CA)

6Pmax_Cy_ave = (1/N) x Z(6Pmax_Cy [N])
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N : Number of cycles
0Pmax_Cy : Averaged crank angle at maximum cylinder pressure of all cylinders
(CA) (calculated value)

24. dPmax[N]
Maximum rate of cylinder pressure rise (kPa/deg)
dPmax[N] = max(dP8 [720,N]) # max: maximum value
N : Number of cycles
dpPe : Rate of cylinder pressure rise (kPa/deg) (calculated value)
25. 6dPmax[N]
Crank angle at maximum rate of cylinder pressure rise (CA)

6dPmax[N] = pos(dP6 [720,N])
# pos: crank angle at the maximum rate of cylinder pressure rise

N : Number of cycles
dpPe : Rate of cylinder pressure rise (kPa/deg) (calculated value)
26. 6dPmax_ave

Averaged crank angle at maximum rate of cylinder pressure rise (CA)

6dPmax_ave = (1 / N) x Z(6dPmax [N])

N : Number of cycles
dPfmax : Crank angle at maximum rate of cylinder pressure rise (CA) (calculated
value)
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5.1 Explanation of Equations

27. dPmax_ave
Averaged maximum rate of cylinder pressure rise (kPa/deg)

dPmax_ave = (1 / N) x Z(dPmax [N])
N: Number of cycles
dPmax : Maximum rate of cylinder pressure rise (kPa/deg) (calculated value)
28. dPmax_std
Standard deviation of maximum rate of cylinder pressure rise (kPa/deg)

dPmax_std = sqrt((1 / (N-1)) x Z(dPmax [N] — dPmax_ave)?)  # sqrt: square root

N: Number of cycles

dPmax : Maximum rate of cylinder pressure rise (kPa/deg) (calculated value)

dPmax_ave : Averaged maximum rate of cylinder pressure rise (kPa/deg) (calculated
value)

29. dPmax_cov
Rate of change (%) in maximum cylinder pressure rise

dPmax_cov = (dPmax_std / dPmax_ave) x 100

dPmax_std : Standard deviation of maximum rate of cylinder pressure rise (kPa/deg)
(calculated value)

dPmax_ave : Averaged maximum rate of cylinder pressure rise (kPa/deg) (calculated
value)

30. dPmax_Cy[N]

Averaged maximum rate of cylinder pressure rise of all cylinders (kPa/deg)

dPmax_Cy[N] = (1 / Cy) x Z(dPmax [Cy, N])

Cy: Number of cylinders
N: Number of cycles
dPmax : Maximum rate of cylinder pressure rise (kPa/deg) (calculated value)

31. dPmax_Cy_ave

Averaged maximum rate of cylinder pressure rise of all cycles and cylinders (kPa/deg)
dPmax_Cy_ave = (1/ N) x Z(dPmax_Cy [N])

N : Number of cycles
dPmax_Cy : Averaged maximum rate of cylinder pressure rise of all cylinders (kPa/
deg) (calculated value)

32. 6dPmax_Cy [N]
Averaged crank angle at maximum rate of cylinder pressure rise of all cylinders (CA)

6dPmax_Cy[N] = (1 / Cy) x Z(6dPmax [Cy, N])

Cy: Number of cylinders

N : Number of cycles

6dPmax : Crank angle at maximum rate of cylinder pressure rise (CA) (calculated
value)
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5.1 Explanation of Equations

33. 6dPmax_Cy_ave

34. Wpower [N]

35. Wpump|[N]

36. Vst

37. NMEP[N]

Averaged crank angle at maximum rate of cylinder pressure rise of all cycles and
cylinders (CA)

6dPmax_Cy_ave = (1/N) x Z(6dPmax_Cy [N])

N : Number of cycles
6dPmax_Cy : Averaged crank angle at maximum rate of cylinder pressure rise of all
cylinders (CA) (calculated value)

Compression/expansion work (J)

AV = abs(V6j — V6i+1) # abs: absolute value

A[N] =X (0.5 x (P6; + P6i+1) x 1000.0 x AV) 6=-180to -1
B[N] = = (0.5 x (P6; + P6i+1) x 1000.0 x AV) 6=0to 179
Whpower[N] = B[N] — A[N]

For a 2-cycle engine, when 6 = 179, P8i:1 is P6;, and V0i:1 is VO_1s0.

N : Number of cycles

Ve : Piston displacement (m®) (calculated value)

PO : Cylinder pressure (kPa) after absolute pressure correction (calculated
value)

Pumping loss (J)

AV = abs(V6i — Vei+l)  # abs: absolute value

C[N] = Z (0.5 x (P6i + P8i+1) x 1000.0 x AV) 6 = 180 to 359
D[N] = = (0.5 x (P6i + P68i+1) x 1000.0 x AV) 6 =-360to —-181
Wpump([N] = C[N] — D[N]

When 6 = 359, P0j.1 is P6;, and V0i+1 is VO _3e0.

Wpump[N] is zero for 2-cycle engines.

N : Number of cycles

Vo : Piston displacement (m®) (calculated value)

PO : Cylinder pressure (kPa) after absolute pressure correction (calculated
value)

Piston displacement (m?®)

Vst=(pi/4)xB2xS

pi: The circular constant

B: Bore (m) (manually input)

S: Stroke length (m) (manually input)
NMEP (kPa)

NMEPIN] = (Wpower [N] / 1000.0 — Wpump[N] / 1000.0) / Vst

N : Number of cycles

Wpower : Compression/expansion work (J) (calculated value)
Wpump : Pumping loss (J) (calculated value)

Vst : Piston displacement (m®) (calculated value)
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5.1 Explanation of Equations

38. NMEP_ave

39. NMEP_std

40. NMEP_cov

41. NMEP_Cy|[N]

42. NMEP_Cy_ave

43. IMEP[N]

44. IMEP_ave

Averaged NMEP (kPa)
NMEP_ave = (1/ N) x Z(NMEP [N])

N : Number of cycles
NMEP : NMEP (kPa) (calculated value)

Standard deviation of NMEP (kPa)

NMEP_std = sqrt((1 / (N-1)) x Z(NMEP [N] - NMEP_ave)?) # sqrt: square root

N : Number of cycles
NMEP : NMEP (kPa) (calculated value)
NMEP_ave : Averaged NMEP (kPa) (calculated value)

Rate of change in NMEP (%)
NMEP_cov = (NMEP_std / NMEP_ave) x 100

NMEP_std : Standard deviation of NMEP (kPa) (calculated value)
NMEP_ave : Averaged NMEP (kPa) (calculated value)

Averaged NMEP of all cylinders (kPa)

NMEP_Cy[N] = (1/ Cy) x Z(NMEP [Cy, N])

Cy: Number of cylinders
N : Number of cycles
NMEP : NMEP (kPa) (calculated value)

Averaged NMEP of all cycles and cylinders (kPa)
NMEP_Cy_ave = (1/N) x Z(NMEP_Cy [N])

N : Number of cycles
NMEP_Cy : Averaged NMEP of all cylinders (kPa) (calculated value)

IMEP (kPa)

IMEP[N] = (Wpower [N] / 1000.0) / Vst

N : Number of cycles
Wpower : Compression/expansion work (J) (calculated value)
Vst : Piston displacement (m®) (calculated value)

Averaged IMEP (kPa)
IMEP_ave = (1 / N) x Z(IMEP [N])

N : Number of cycles
IMEP : IMEP (kPa) (calculated value)
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5.1 Explanation of Equations

45. IMEP_std

46. IMEP_cov

47. IMEP_min

48. IMEP_LNV

49. R_misfire

50. IMEP_Cy|[N]

51. IMEP_Cy_ave

Standard deviation of IMEP (kPa)
IMEP_std = sqrt((1 / (N-1)) x Z(IMEP [N] — IMEP_ave)?) # sqrt: square root

N : Number of cycles
IMEP : IMEP (kPa) (calculated value)
IMEP_ave : Averaged IMEP (kPa) (calculated value)

Rate of change in IMEP (%)
IMEP_cov = (IMEP_std / IMEP_ave) x 100

IMEP_std :  Standard deviation of IMEP (kPa) (calculated value)
IMEP_ave : Averaged IMEP (kPa) (calculated value)

Minimum value of IMEP (kPa)

IMEP_min = min (IMEP[N]) # min: minimum value
N : Number of cycles
IMEP : IMEP (kPa) (calculated value)

LNV of IMEP (%)
IMEP_LNV = (IMEP_min / IMEP_ave) x 100

IMEP_min :  Minimum value of IMEP (kPa)
IMEP_ave : Averaged IMEP (kPa) (calculated value)

Rate of misfire (%)

R_misfire = (count(IMEP[N] < L) / N) x 100
# count: calculates the number of data that are applicable to the specified conditions

N : Number of cycles
L: Value for judging misfire (kPa) (manually input)
IMEP : IMEP (kPa) (calculated value)

Averaged IMEP of all cylinders (kPa)

IMEP_Cy|[N] = (1 / Cy) x =(IMEP [Cy, N])

Cy: Number of cylinders
N : Number of cycles
NMEP : IMEP (kPa) (calculated value)

Averaged IMEP of all cycles and cylinders (kPa)
IMEP_Cy_ave = (1/N) x Z(IMEP_Cy [N])

N : Number of cycles
IMEP_Cy: Averaged IMEP of all cylinders (kPa) (calculated value)
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5.1 Explanation of Equations

52. PMEP[N]
PMEP (kPa)
PMEP[N] = ((-1 x Wpump [N]) / 1000.0) / Vst
N : Number of cycles
Wpump : Pumping loss (J) (calculated value)
Vst : Piston displacement (m®) (calculated value)
53. PMEP_ave
Averaged PMEP (kPa)
PMEP_ave = (1/ N) x Z(PMEP [N])
N : Number of cycles
PMEP : PMEP (kPa) (calculated value)
54. PMEP_std
Standard deviation of PMEP (kPa)
PMEP_std = sqrt((1 / (N-1)) x Z(PMEP[N] — PMEP_ave)?)  # sqrt: square root
N : Number of cycles
PMEP : PMEP (kPa) (calculated value)
PMEP_ave : Averaged PMEP (kPa) (calculated value)
55. PMEP_cov

Rate of change in PMEP (%)
PMEP_cov = (PMEP_std / PMEP_ave) x 100
PMEP_std : Standard deviation of PMEP (kPa) (calculated value)
PMEP_ave : Averaged PMEP (kPa) (calculated value)
56. PMEP_Cy[N]
Averaged PMEP of all cylinders (kPa)

PMEP[N] = (1 / Cy) x (IMEP [Cy, N])

Cy: Number of cylinders
N : Number of cycles
NMEP : PMEP (kPa) (calculated value)

57. PMEP_Cy_ave
Averaged PMEP of all cycles and cylinders (kPa)

PMEP_Cy_ave = (1/N) x S(PMEP_Cy [N])

N : Number of cycles
PMEP_Cy: Averaged PMEP of all cylinders (kPa) (calculated value)

58. TO [720,N], dQ6 [720,N], Q6 [720,N]
T [720,N] : Cylinder gas temperature (°C)
dQe6 [720,N] : Rate of heat release (J/deg)
Q6 [720,N] : Amount of heat release (J)
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5.1 Explanation of Equations

(1) Gf

Mass of intake fuel (kg)

Gf = (Gfuel x (1 /1000) x Cv) x ((60 x En_cyl) / Ne)

When fuel consumption and rpm are set to be measured and used in calculations:
Gf[N] = (Gfuel_ave[N] x (1 / 1000) x Cv) x ((60 x En_cyl) / Ne_ave[N])

N:
Gfuel :

Cv:
En_cyl:

Ne:

(2) Ga

Number of cycles

Fuel consumption (cm®/sec) (manually input)

Uses average fuel comsumption at each cycle when fuel consumption is
set to be measured and used in calculations.

Gfuel_ave[N] = ave(Gfuel[720,N]) / Sn # ave: average value
Sn: Number of cylinders (used to calculate fuel consumption)
Specific gravity (manually input)

Engine cycle

4-cycle engine: En_cyl =2

2-cycle engine: En_cyl =1

Revolutions per minute (rpm) (manually input)

Uses average rpm at each cycle when rpm is set to be measured and
used in calculations.

Ne_ave[N] = ave(Ne[720,N]) # ave: average value

Mass of intake air (kg)

Ga = (Veff / 100) x (( Pa x (10000 / 98.0665) x Vst) / (29.27 x (Td + 273.16)))

When intake manifold pressure and intake manifold temperature are set to be measured
and used in calculations:
Ga[N] = (Veff / 100) x (( Pitk_ave[N] x (10000 / 98.0665) x Vst) / (29.27 x (Td_ave

+273.16)))

N :
Veff:
Pa:

Vst :

Td :

Number of cycles

Suction volumetric efficiency (%) (manually input)

Atmospheric pressure (kPa) (manually input)

Uses Pitk_ave[N] (average intake manifold pressure at each cycle,
calculated value) when intake manifold pressure is set to be measured
and used in calculations.

Piston displacement (m®) (calculated value)

Atmospheric temperature (°C) (manually input)

Uses the average intake manifold temperature at each cycle when intake
manifold temperature is set to be measured and used in calculations.
Td_ave[N] = ave(Td[720,N]) # ave: average value
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5.1 Explanation of Equations

(3) As:

(4) Rr

(5) Gr

Excess air factor
As = Ga/ (Thair x Gf)

When fuel consumption, rpm, intake manifold pressure, and intake manifold temperature
are set to be measured and used in calculations:
As[N] = Ga[N] / (Thair x Gf[N])

Ga: Mass of intake air (kg) (calculated value)
Uses Ga[N] (mass of intake air at each cycle, calculated value) when
intake manifold pressure and intake manifold temperature are set to be
measured and used in calculations.

Thair: Theoretical air (= 14.512 kg)

Gf: Mass of intake fuel (kg) (calculated value)
Uses Gf[N] (mass of intake fuel at each cycle, calculated value) when
fuel consumption and rpm are set to be measured and used in
calculations.

Corrected gas constant

GN2 = (11.211 x As) / (1 + 14.5977 x As)

GO2 = (3.3867 x (hs-1) / (1 + 14.5977 x As)

GCO2=3.1717/ (1 + 14.5977 x As)

GH20 = 1.215/ (1 + 14.5977 x As)

Rr = (30.26 x GN2) + (26.49 x GO2) + (19.26 x GCO2) + (47.06 x GH20)

When fuel consumption, rpm, intake manifold pressure, and intake manifold temperature
are set to be measured and used in calculations:

GN2[N] = (11.211 x As[N]) / (1 + 14.5977 x As[N])

GO2[N] = (3.3867 x (AS[N] - 1) / (1 + 14.5977 x As[N])

GCO2[N] =3.1717 / (1 + 14.5977 x As[N])

GH20[N] = 1.215/ (1 + 14.5977 x As[N])

Rr[N] = (30.26 x GN2[N]) + (26.49 x GO2[N]) + (19.26 x GCO2[N]) + (47.06 x GH2O[N])

As: Excess air factor (calculated value)
Uses As[N] (excess air factor at each cycle, calculated value) when fuel
consumption, rpm, intake manifold pressure, and intake manifold
temperature are set to be measured and used in calculations.

Mass of remaining gas (kg)

Without a supercharger (manually selected)
Gr = (Pex x (10000 / 98.0655) x Vst) / (Rr x (Tex + 273.16) x (¢ - 1))

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature,
exhaust gas pressure, and exhaust gas temperature are set to be measured and used in
calculations:

Gr[N] = (Pex_ave[N] x (10000 / 98.0655) x Vst) / (Rr[N] x (Tex_ave[N]+273.16) x (¢-1))

With a supercharger (manually selected)

a = ((Tturbin + 273.16) / 1.1 - (Tboost + 273.16)) / (Tturbin — Thoost)

(ae=0.9 when o > 0.9)

Gr = ((1 - a) x Pturbin x (10000 / 98.0655) x Vst) / (Rr x (Tturbin + 273.16) x (¢ — 1))

5-12

IM 707766-61E



5.1 Explanation of Equations

When the fuel consumption, rpm, intake manifold pressure, intake manifold temperature,
supercharger inlet pressure, supercharger inlet temperature, and boost temprature
(intake manifold temperature) are set to be measured and used in calculations:

a[N] = ((Tturbin_ave[N] + 273.16) / 1.1 - (Td_ave[N] + 273.16)) / (Tturbin_ave[N]

- Td_ave[N])

(a[N] = 0.9 when a[N] > 0.9)
Gr[N] = ((1 - a[N]) x Pturbin_ave[N] x (10000 / 98.0655) x Vst) / (Rr[N] x (Tturbin_ave[N]
+273.16) x (¢ - 1))

Pex:

Vst:
Rr:

Tex:

€
Tturbin:

Thoost:

Pturbin:

Exhaust gas pressure (kPa) (manually input)

Uses average exhaust gas pressure at each cycle when exhaust gas
pressure is set to be measured and used in calculations.

Pex_ave[N] = ave(Pex[720,N]) # ave: average value

Piston displacement (m®) (calculated value)

Corrected gas constant (calculated value)

Uses Rr[N] (corrected gas constant for each cycle, calculated value)
when fuel consumption, rpm, intake manifold pressure, and intake
manifold temperature are set to be measured and used in calculations.
Exhaust gas temperature (°C) (manually input)

Uses average exhaust gas temperature at each cycle when exhaust gas
temperature is set to be measured and used in calculations.
Tex_ave[N] = ave(Tex[720,N]) # ave: average value
Compression ratio (manually input)

Supercharger inlet temperature (°C) (manually input)

Uses average supercharger inlet temperature at each cycle when
supercharger inlet temperature is set to be measured and used in
calculations.

Tturbin_ave[N] = ave(Tturbin[720,N]) # ave: average value
Boost temperature (°C) (manually)

Uses average intake manifold temperature at each cycle when intake
manifold temperature is set to be measured and used in calculations.
Td_ave[N] = ave(Td[720,N]) # ave: average value
Supercharger inlet pressure (kPa) (manually input)

Uses average supercharger inlet pressure at each cycle when
supercharger inlet pressure is set to be measured and used in
calculations.

Pturbin_ave[N] = ave(Pturbin[720,N]) # ave: average value
Turbine Blower
[/ N 1. Boost pressure (Pt)
2. Supercharger inlet pressure (Pturbin)
56 3. Supercharger inlet temperature (Tturbin)
2,3 /L& 1,4 4. Boost temperature (Thoost)
-— - 5. Exhaust gas pressure (Pex)
q|> 6. Exhaust gas temperature (Tex)
IM 707766-61E 5-13
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5.1 Explanation of Equations

(6) Initial Values (-360 CA (-180 CA for 2-Cycle Engines) — Point a: Start Point of Heat

Release)

(6-1) TO [O,N]

Repeatedly calculates from (6-1) to (6-6) for the interval as follows:

From 6 = -360CA (-180CA for 2-cycle engine) to the crank angle (point a) at which dQ6
changes to a positive value immediately before dQ6 becomes dQmax (the maximum
value of dQ6).

Gas temperature (K)

Gt0 = Ga+Gr

Gab = Ga+Gr x (1-Gf/ Ga)

Grb = Gr x Gf/ Ga

hamo = Gab / (Thair x Grb)

RO =R - (0.14 / hamo)

T6 [6,N] = P6 [6,N] x (10000 / 98.0665) x V6 [6] / (GtO x RO)

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature,
supercharger inlet pressure, supercharger inlet temperature, boost temperature (intake
manifold temperature), exhaust gas pressure, and exhaust gas temperature are set to be
measured and used in calculations:

GtO[N] = Ga[N] + Gr[N]

Gab[N] = Ga[N] + Gr [N]x (1 - Gf[N]/ Ga[N])

Grb[N] = Gr[N] x Gf[N] / Ga[N]

ramo[N] = Gab[N] / (Thair x Grb[N])

RO[N] = R - (0.14 / hamo[N])

T6 [6,N] = P6 [6,N] x (10000 / 98.0665) x V6 [0] / (GtO[N] x RO[N])

GtO: Total mass of gas (kg)

Ga: Mass of intake air (kg) (calculated value)
Uses Ga[N] (mass of intake air at each cycle, calculated value) when
intake manifold pressure and intake manifold temperature are set to be
measured and used in calculations.

Gr: Mass of remaining gas (kg) (manually input)
Uses Gr[N] (mass of remaining gas at each cycle, calculated value)
when fuel consumption, rpm, intake manifole pressure, intake manifold
temperature, exhaust gas pressure, exhaust gas temperature,
supercharger inlet pressure, supercharger inlet temperature, and boost
temperature (intake manifold temperature) are set to be measured and
used in calculations.

Gf: Mass of intake fuel (kg) (calculated value)
Uses Gf[N] (mass of intakefuel at each cycle, calculated value) when
fuel consumption and rpm are set to be measured and used in

calculations.

hamo: Average excess air factor

Thair: Theoretical air (= 14.512 kg)

R: Gas constant (= 29.27) (x 9.80665 J/kg.K) (manually input)

PO : Cylinder pressure (kPa) after absolute pressure correction (calculated
value)

Vo: Piston displacement (m®) (calculated value)
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5.1 Explanation of Equations

(6-2) k0 [6,N]

(6-3) dQrecib [6,N]

(6-4) dQwi®

Ratio of specific heat
x0 [6,N] = 1.4373 - 1.318 x 10™* x TO [6,N] + 3.12 x 1078 x TO [6,N]? - 4.8 x 1072 / Aamo

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature,
supercharger inlet pressure, supercharger inlet temperature, boost temperature (intake
manifold temperature), exhaust gas pressure, and exhaust gas temperature are set to be
measured and used in calculations:
k0 [6,N] = 1.4373 - 1.318 x 10* x TO [0,N] + 3.12 x 1078 x TO [0,N]? - 4.8 x 1072

/ hamo[N]

TO : Gas temperature (K) (calculated value)

hamo: Average excess air factor (calculated value)
Uses Aamo[N] (average excess air factor at each cycle, calculated
value) when fuel consumption, rpm, intake manifold pressure, intake
manifold temperature, supercharger inlet pressure, supercharger inlet
temperature, boost temperature (intake manifold temperature), exhaust
gas pressure, and exhaust gas temperature are set to be measured and
used in calculations.

Rate of heat release (received heat) (J/deg)

dQrecio [0,N] = k0 [0,N] / (0 [6,N] - 1) x PO [0,N] x 1000.0 x dV0 [6] + 1 / (6 [0,N] - 1)
x dPO [0,N] x 1000.0 x VO [6]

K6: Rate of specific heat (calculated value)

PO : Cylinder pressure (kPa) after absolute pressure correction (calculated
value)

dve : Rate of cylinder volume increase (m®/deg) (calculated value)

Veo: Piston displacement (m®) (calculated value)

dpPo : Rate of cylinder pressure rise (kPa/deg) (calculated value)

Rate of heat release (heat loss) (J/deg)

When taking heat loss into account (manually select)
Cm=2xSxNe/60
Sh=B%xpi/4
Sp = PistHr x Sh
FO [6] = (VO [6] / Sh) x pi x B
dQwig# [8,N] = 256 x B124 x (Cm x P8 [6,N] / (10000 / 98.0665))°78 x (T6 [6,N]~°-525)
Twall_K = Twall + 273.16
dQwisle [6,N] = 0.362 x ((T6 [6,N] / 100)* — (Twall_K / 100)*) / (T6 [8,N]-Twall_K)
TwallH_K = TwallH + 273.16
dQwish6 [6,N] = 0.362 x ((T6 [6,N] / 100)* - (TwallH_K / 100)*) / (T8 [6,N] - TwallH_K)
TwallP_K = TwallP + 273.16
dQwisp6 [6,N] = 0.362 x ((T6 [6,N] / 100)* - (TwallP_K / 100)*) / (T6 [6,N] - TwallP_K)
dQwio [6,N] = (((dQwige [6,N] + dQwisle [6,N]) x FO [6] x (T8 [6,N] - Twall_K)

+ dQwig6 [6,N] + dQwish6 [6,N]) x Sh x (T6 [6,N] - TwallH_K) + dQwig6 [6,N]

+ dQwispo [0,N]) x Sp x (T8 [6,N] - TwallP_K)) / (6 x Ne x 3600)) x 4.18605 x 10°
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5.1 Explanation of Equations

(6-5) dQO

(6-6) Q6 [6,N]

When rpm is set to be measured and used in calculations:
Cm[N] =2 x S x Ne_ave[N]/ 60
Sh=B2xpi/4
Sp = PistHr x Sh
Fo [0] = (VO [0]/ Sh) x pi x B
dQwigh [6,N] = 256 x B4 x (Cm[N] x P6 [6,N] / (10000 / 98.0665))° 786
x (TO [G,N]-o.szs)
Twall_K = Twall + 273.16
dQwislo [6,N] = 0.362 x ((T6 [6,N] / 100)* - (Twall_K / 100)*) / (T6 [6,N] - Twall_K)
TwallH_K = TwallH + 273.16
dQwish6 [6,N] = 0.362 x ((T6 [6,N] / 100)* - (TwallH_K / 100)*) / (T6 [6,N] - TwallH_K)
TwallP_K = TwallP + 273.16
dQwisp# [6,N] = 0.362 x ((T6 [6,N] / 100)* - (TwallP_K / 100)*) / (T6 [6,N] - TwallP_K)
dQwio [8,N] = (((dQwige [6,N] + dQwisle [8,N]) x Fo [0] x (T8 [6,N] - Twall_K)
+ dQwig6 [6,N] + dQwish® [6,N]) x Sh x (T8 [8,N] - TwallH_K) + dQwige [6,N]
+ dQwispe [6,N]) x Sp x (T8 [6,N] - TwallP_K)) / (6 x Ne_ave[N] x 3600)) x 4.18605
x 10°

When not taking heat loss into account

dQwib [6] =0

Cm: Average piston speed (m/s)
Uses Cm[N] (average piston speed at each cycle) when rpm is set to be
measured and used in calculations.

S: Stroke (m) (manually input)

Ne: Revolutions per minute (rpm) (manually input)
Uses Ne_ave[N] (average rpm at each cycle) when rpm is set to be
measured and used in calculations.
Ne_ave[N] = ave(Ne[720,N]) # ave: average value

Sh: Cylinder cross-sectional area (m?)

B: Bore (m) (manually input)

pi: The circular constant

Sp: Area of the piston head (m?) (manually input)

PistHr: Piston head ratio (manually input)

Fo: Cylinder clearance (m?)

Veo: Piston displacement (m®) (calculated value)

Twall: Cylinder wall temperature (°C) (manually input)

TO : Gas temperature (K) (calculated value)

TwallH: Cylinder head wall temperature (°C) (manually input)

TwallP: Piston head wall temperature (°C) (manually input)

Rate of heat release (J/deg)
dQe6 [6,N] = dQreci6 [6,N] + dQwi6 [6,N]
dQreci6: Rate of heat release (received heat) (J/deg) (calculated value)

dQwie: Rate of heat release (heat loss) (J/deg) (calculated value)

Amount of heat release (J)

QO [0,N]=0
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5.1 Explanation of Equations

(7) Combustion Period (Point a: Start Point of Heat Release to Point b: End Point of

Heat Release)

(7-1)TO

Repeatedly calculates from (7-1) to (7-6) until the following conditions are satisfied:
From 6 = point a until the crank angle at which dQ6 changes to a negative value
immediately after dQ6 becomes dQmax (the maximum value of dQ6). Use the value for
Qprevl in (7-5) in (7-5).

Q0 =Gf x Hu

Qprevd =0
Hu : Amount of heat release at the lowest position (J/kg) (manually input)
Gf: Mass of intake fuel (kg) (calculated value)
Qpreve: Amount of heat release at the current angle (J)

Gas temperature (K)

Gab=Ga+ Grx (1 - Gf/ Ga)

Grb = Gr x Gf/ Ga

Gt06 = Gab + Grb + Qprev6 / Hu

Aamob = Gab / (Thair x (Grb + Qpreve / Hu))

RO6 =R - (0.14 / hamo6)

T6 [6,N] = PO [6,N] x (10000 / 98.0665) x V6 [6] / (Gt06 x R0OB)

suonenbg ﬂ

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature,
supercharger inlet pressure, supercharger inlet temperature, boost temperature (intake
manifold temperature), exhaust gas pressure, and exhaust gas temperature are set to be
measured and used in calculations:

Gab[N] = Ga[N] + Gr[N] x (1 - Gf[N] / Ga[N])

Grb[N] = Gr[N] x Gf[N] / Ga[N]

Gt06 [N] = Gab[N] + Grb[N] + Qprev6 / Hu

AamoB[N] = Gab[N] / (Thair x (Grb[N] + Qpreve / Hu))

ROO[N] = R - (0.14 / Aamo6[N])

T6 [6,N] = P6 [6,N] x (10000 / 98.0665) x VO [0] / (GtOB[N] x ROB[N])

Ga: Mass of intake air (kg) (calculated value)
Uses Ga[N] (mass of intake air at each cycle, calculated value) when
intake manifold pressure and intake manifold temperature are set to be
measured and used in calculations.

Gr: Mass of remaining gas (kg) (calculated value)
Uses Gr[N] (mass of remaining gas at each cycle, calculated value)
when fuel consumption, rpm, intake manifole pressure, intake manifold
temperature, exhaust gas pressure, exhaust gas temperature,
supercharger inlet pressure, supercharger inlet temperature, and boost
temperature (intake manifold temperature) are set to be measured and
used in calculations.

Gf Mass of intake fuel (kg) (calculated value)
Uses Gf[N] (mass of intakefuel at each cycle, calculated value) when
fuel consumption and rpm are set to be measured and used in

calculations.
Qprev: Amount of heat release at the current angle (J) (calculated value)
Hu: Amount of heat release at the lowest position (J/kg) (manually input)

IM 707766-61E
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5.1 Explanation of Equations

Thair:
R:
Po:
Veo:

(7-2) %6 [6,N]

Theoretical air (= 14.512 kg)

Gas constant (= 29.27) (x 9.80665 J/kg.K) (manually input)

Cylinder pressure (kPa) after absolute pressure correction (calculated
value)

Piston displacement (m®) (calculated value)

Ratio of specific heat

k0 [6,N] = 1.4373 - 1.318 x 10* x TO [0,N] + 3.12 x 1078 x TO [6,N]? - 4.8 x 1072 / Aamob

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature,
supercharger inlet pressure, supercharger inlet temperature, boost temperature (intake
manifold temperature), exhaust gas pressure, and exhaust gas temperature are set to be
measured and used in calculations:

k0 [6,N] = 1.4373 - 1.318 x 10* x TO [0,N] + 3.12 x 1078 x TO [0,N]? - 4.8 x 1072

/ hamo8[N]

TO :
Aamoo:

(7-3) dQreci

Gas temperature (K) (calculated)

Average excess air factor (calculated value)

Uses Aamo[N] (average excess air factor at each cycle, calculated
value) when fuel consumption, rpm, intake manifold pressure, intake
manifold temperature, supercharger inlet pressure, supercharger inlet
temperature, boost temperature (intake manifold temperature), exhaust
gas pressure, and exhaust gas temperature are set to be measured and
used in calculations.

Rate of heat release (received heat) (J/deg)

dQreci[d,N] = k6 [8,N] / (6 [6,N] - 1) x PO [0,N] x 1000.0 x dV6 [6] + 1 / (x6 [0,N] - 1)
x dP@ [0,N] x 1000.0 x VO [6]

K0:
PO :

Vo:

(7-4) dQwi6 [6,N]

Ratio of specific heat

Cylinder pressure (kPa) after absolute pressure correction (calculated
value)

Piston displacement (m®) (calculated value)

Rate of heat release (heat loss) (J/deg)

When taking heat loss into account (manually select)
Cm=2xSxNe/60
Fo [6] = (Ve [0] / Sh) x pi x B
dQwigh [6,N] = 256 x B4 x (Cm x P8 [6,N] / (10000 / 98.0665))°-786 x (T6 [6,N]°-52)
Twall_K = Twall + 273.16
dQwisle [6,N] = 0.362 x ((T6 [6,N] / 100)* - (Twall_K / 100)*) / (T6 [6,N] - Twall_K)
TwallH_K = TwallH + 273.16
dQwish6 [6,N] = 0.362 x ((T6 [6,N] / 100)* - (TwallH_K / 100)*) / (T6 [6,N] - TwallH_K)
TwallP_K = TwallP + 273.16
dQwisp# [6,N] = 0.362 x ((T6 [6,N] / 100)* - (TwallP_K / 100)*) / (T6 [6,N] - TwallP_K)
dQwio [8,N] = (((dQwige [6,N] + dQwisle [6,N]) x F0 [6] x (T8 [6,N] - Twall_K)

+ (dQwighb [6,N] + dQwish6 [6,N]) x Sh x (T6 [6,N] - TwallH_K) + (dQwig6 [6,N]

+ dQwispo [6,N]) x Sp x (T8 [6,N] - TwallP_K)) / (6 x Ne x 3600)) x 4.18605 x 103
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5.1 Explanation of Equations

(7-5) dQO

When rpm is set to be measured and used in calculations:
Cm[N] =2 x S x Ne_ave[N]/ 60
Fo [0] = (VO [8]/ Sh) x pi x B
dQwigh [8,N] = 256 x B=9124 x (Cm[N] x P6 [6,N] / (10000 / 98.0665))° 786
x (T6 [6,N]9-5%5)
Twall_K = Twall + 273.16
dQwisle [6,N] = 0.362 x ((T6 [6,N] / 100)* - (Twall_K / 100)*) / T6 [6,N] - Twall_K)
TwallH_K = TwallH + 273.16
dQwish6 [6,N] = 0.362 x ((T6 [6,N] / 100)* - (TwallH_K / 100)*) / (T6 [6,N] - TwallH_K)
TwallP_K = TwallP + 273.16
dQwisp6 [6,N] = 0.362 x ((T6 [6,N] / 100)* - (TwallP_K / 100)*) / (T6 [6,N] - TwallP_K)
dQwie [6,N] = (((dQwig [6,N] + dQwislo [8,N]) x FO [0] x (T6 [6,N] - Twall_K)
+ (dQwighb [6,N] + dQwish6 [6,N]) x Sh x (T6 [6,N] — TwallH_K) + (dQwig6 [6,N]
+ dQwispd [6,N]) x Sp x (T6 [0,N] - TwallP_K)) / (6 x Ne_ave[N] x 3600)) x 4.18605
x 10°

When not taking heat loss into account

dQwi[e] =0

Cm: Average piston speed (m/s)
Uses Cm[N] (average piston speed at each cycle) when rpm is set to be
measured and used in calculations.

S: Stroke (m) (manually input)

Ne: Revolutions per minute (rpm) (manually input)
Uses Ne_ave[N] (average rpm at each cycle) when rpm is set to be
measured and used in calculations.
Ne_ave[N] = ave(Ne[720,N]) # ave: average value

Veo: Piston displacement (m®) (calculated value)

Sh: Cylinder cross-sectional area (m?)

B: Bore (m) (manually input)

pi: The circular constant

Fo: Cylinder clearance (m?)

Sp: Area of the piston head (m?) (manually input)

Twall: Cylinder wall temperature (°C) (manually input)

TO : Gas temperature (K) (calculated value)

TwallH: Cylinder head wall temperature (°C) (manually input)

TwallP: Piston head wall temperature (°C) (manually input)

Rate of heat release (J/deg)

dQe [6,N] = dQrecib [6,N] + dQwib [0,N]
Qprevd = Qprevo + dQ6 [6,N] x res
When Qpreve > QO0, Qprevd = Q0.
For dQ6 < 0, do not add.

dQrecid: Rate of heat release (received heat) (J/deg) (calculated value)
dQwib: Rate of heat release (heat loss) (J/deg) (calculated value)

res: Angle resolution (manually input)

Qpreve: Amount of heat release at the current angle (J)

QO: = Gf x Hu

Uses Gf[N] (mass of intakefuel at each cycle, calculated value) when
fuel consumption and rpm are set to be measured and used in
calculations.
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5.1 Explanation of Equations

(7-6) Q6 [6,N]

Amount of heat release (J)
Q6 [0,N] = Qprevo

Qprevo: Amount of heat release at the current angle (J)

(8) From the End Point of Heat Release (Point b: End Point of Heat Release to +360 CA
(+180 CA for 2-Cycle Engines))

(8-1) TO

Repeatedly calculates from (8-1) to (8-6) from q = point b to +360 CA (+180 CA for 2-
cycle engines)

Q0 = Q6 [b,N]
Q6 [b,N]: Amount of heat release at point b (J)

Gas temperature (K)

Gab = Ga+Gr x (1-Gf/ Ga)

Grb = Gr x Gf/ Ga

Gt0O =Gab + Grb + Q0 / Hu

hamo = Gab / (Thair x (Grb + QO / Hu)

RO =R - (0.14 / hamo)

T6 [6,N] = P6 [6,N] x (10000 / 98.0665) x V6 [0] / (GtO x RO)

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature,
supercharger inlet pressure, supercharger inlet temperature, boost temperature (intake
manifold temperature), exhaust gas pressure, and exhaust gas temperature are set to be
measured and used in calculations:

Gab[N] = Ga[N] + Gr[N] x (1 - Gf[N] / Ga[N])

Grb[N] = Gr[N] x Gf[N] / Ga[N]

GtO[N] = Gab[N] + Grb[N] + Q0 / Hu

Aamo[N] = Gab[N] / (Thair x (Grb[N] + QO / Hu)

RO[N] = R - (0.14 / Aamo[N])

T6 [6,N] = P6 [6,N] x (10000 / 98.0665) x V6 [0] / (GtO[N] x RO[N])

Ga: Mass of intake air (kg) (calculated value)
Uses Ga[N] (mass of intake air at each cycle, calculated value) when
intake manifold pressure and intake manifold temperature are set to be
measured and used in calculations.

Gr: Mass of remaining gas (kg) (calculated value)
Uses Gr[N] (mass of remaining gas at each cycle, calculated value)
when fuel consumption, rpm, intake manifole pressure, intake manifold
temperature, exhaust gas pressure, exhaust gas temperature,
supercharger inlet pressure, supercharger inlet temperature, and boost
temperature (intake manifold temperature) are set to be measured and
used in calculations.

Gf: Mass of intake fuel (kg) (calculated value)
Uses Gf[N] (mass of intakefuel at each cycle, calculated value) when
fuel consumption and rpm are set to be measured and used in

calculations.

Qo: Amount of heat release at point b (J) (calculated value)

Hu: Amount of heat release at the lowest position (J/kg) (manually input)

Thair: Theoretical air (= 14.512 kg)

R: Gas constant (= 29.27) (x 9.80665 J/kg K) (manually input)

PO : Cylinder pressure (kPa) after absolute pressure correction (calculated
value)

ve: Piston displacement (m®) (calculated value)
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5.1 Explanation of Equations

(8-2) k0 [6,N]

(8-3) dQreci

(8-4) dQwi6 [6,N]

Ratio of specific heat
k0 [6,N] = 1.4373 - 1.318 x 10 x TO[O,N] + 3.12 x 1078 x TO [8,N]*- 4.8 x 1072/ Aamo

When fuel consumption, rpm, intake manifold pressure, intake manifold temperature,
supercharger inlet pressure, supercharger inlet temperature, boost temperature (intake
manifold temperature), exhaust gas pressure, and exhaust gas temperature are set to be
measured and used in calculations:
k0 [6,N] = 1.4373 - 1.318 x 10* x TO [0,N] + 3.12 x 1078 x TO [0,N]? - 4.8 x 1072

/ hamo[N]

TO : Gas temperature (K) (calculated value)

hamo6: Average excess air factor (calculated value)
Uses Aamo[N] (average excess air factor at each cycle, calculated
value) when fuel consumption, rpm, intake manifold pressure, intake
manifold temperature, supercharger inlet pressure, supercharger inlet
temperature, boost temperature (intake manifold temperature), exhaust
gas pressure, and exhaust gas temperature are set to be measured and
used in calculations.

Rate of heat release (received heat) (J/deg)

dQreci [0,N] = k0 [0,N] / (6 [0,N] - 1) x PO [6,N] x 1000.0 x dV@ [6] + 1 / (k6 [0,N] - 1)
x dPO [6,N] x 1000.0 x V@ [0]

K6: Ratio of specific heat

Po: Cylinder pressure (kPa) after absolute pressure correction (calculated
value)

Veo: Piston displacement (m®) (calculated value)

Rate of heat release (heat loss) (J/deg)

When taking heat loss into account (manually select)
Cm=2xSxNe/60
FO [6] = (VO [6] / Sh) x pi x B
dQwigh [6,N] = 256 x B4 x (Cm x P [6,N] / (10000 / 98.0665))" 788 x (T6 [0,N] 252
Twall_K = Twall + 273.16
dQwisle [6,N] = 0.362 x ((T6 [6,N] / 100)* - (Twall_K / 100)*) / (T6 [8,N] - Twall_K)
TwallH_K = TwallH + 273.16
dQwish6 [6,N] = 0.362 x ((T6 [6,N] / 100)* - (TwallH_K / 100)*) / (T6 [6,N] - TwallH_K)
TwallP_K = TwallP + 273.16
dQwisp6 [6,N] = 0.362 x ((T6 [6,N] / 100)* - (TwallP_K / 100)*) / (T6 [8,N] - TwallP_K)
dQwio [6,N] = (((dQwige [6,N] + dQwisle [6,N]) x F6 [6] x (T8 [6,N] - Twall_K)

+ (dQwigb [6,N] + dQwish6 [6,N]) x Sh x (T6 [6,N] — TwallH_K) + (dQwig6 [6,N]

+ dQwispo [6,N]) x Sp x (T8 [6,N] - TwallP_K)) / (6 x Ne x 3600)) x 4.18605 x 10°

When rpm is set to be measured and used in calculations:

Cm[N] =2 x S x Ne_ave[N] / 60

F6 [6] = (VB [6] / Sh) x pi x B

dQwig# [8,N] = 256 x B9124 x (Cm[N] x P8 [6,N] / (10000 / 98.0665))°78°
x (T [6,N]7%5%)

IM 707766-61E

5-21

suonenbg ﬂ



5.1 Explanation of Equations

(8-5) dQO

(8-6) Q6 [6,N]

(9) TO

Twall_K = Twall + 273.16
dQwisle [6,N] = 0.362 x ((T6 [6,N] / 100)* - (Twall_K / 100)*) / (T6 [6,N] - Twall_K)
TwallH_K = TwallH + 273.16
dQwish6 [6,N] = 0.362 x ((T6 [6,N] / 100)* - (TwallH_K / 100)*) / (T6 [6,N] - TwallH_K)
TwallP_K = TwallP + 273.16
dQwisp# [6,N] = 0.362 x ((T6 [6,N] / 100)* - (TwallP_K / 100)*) / (T6 [6,N] - TwallP_K)
dQwio [6,N] = (((dQwige [6,N] + dQwisle [6,N]) x F0 [6] x (T8 [6,N] - Twall_K)

+ (dQwighb [6,N] + dQwish6 [6,N]) x Sh x (T6 [6,N] — TwallH_K) + (dQwig6 [6,N]

+ dQwispb [6,N]) x Sp x (T6 [6,N] - TwallP_K)) / (6 x Ne_ave[N] x 3600))

x 4.18605 x 10°

When not taking heat loss into account

dQwi[8] =0

Cm: Average piston speed (m/s)
Uses Cm[N] (average piston speed at each cycle) when rpm is set to be
measured and used in calculations.

S: Stroke (m) (manually input)

Ne: Revolutions per minute (rpm) (manually input)
Uses Ne_ave[N] (average rpm at each cycle) when rpm is set to be
measured and used in calculations.
Ne_ave[N] = ave(Ne[720,N]) # ave: average value

Ve: Cylinder volume (m®) (calculated value)

Sh: Cylinder cross-sectional area (m?)

B: Bore (m) (manually input)

pi: The circular constant

Fo: Cylinder clearance (m?)

Sp: Area of the piston head (m?) (manually input)

Twall: Cylinder wall temperature (°C) (manually input)

TO : Gas temperature (K) (calculated value)

TwallH: Cylinder head wall temperature (°C) (manually input)

TwallP: Piston head wall temperature (°C) (manually input)

Rate of heat release (J/deg)
dQeo [6,N] = dQreci6 [6,N] + dQwi6 [8,N]

dQreci6: Rate of heat release (received heat) (J/deg) (calculated value)
dQwi6: Rate of heat release (heat loss) (J/deg) (calculated value)

Amount of heat release (J)

Q6 [6,N] = Q0

Qo: Amount of heat release at point b (J)

Cylinder gas temperature (°C)
TO [720,N] = T [720,N] - 273.16

TO : Gas temperature (K) (calculated value)
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5.1 Explanation of Equations

59. TO ave[720]

Average cylinder gas temperature (°C)
TO ave[720] = (1 / N) x Z(T6 [720,N])
N : Number of cycles
TO : Cylinder gas temperature (°C) (calculated value)
60. Tmax[N]
Maximum cylinder gas temperature (°C)
Tmax[N] = max(T6e [720,N])
N : Number of cycles
TO : Cylinder gas temperature (°C) (calculated value)
61. 6Tmax[N]
Crank angle (CA) at maximum cylinder gas temperature
6Tmax[N] = pos(T6 [720,N])  # pos: crank angle at the maximum cylinder gas temperature
N : Number of cycles
TO : Cylinder gas temperature (°C) (calculated value)
62. Tmax_ave
Averaged maximum cylinder gas temperature (°C)
Tmax_ave = (1 / N) x Z(Tmax [N])
N : Number of cycles
Tmax : Maximum cylinder gas temperature (°C) (calculated value)
63. Tmax_std
Standard deviation of maximum cylinder gas temperature (°C)
Tmax_std = sqrt((1 / (N-1)) x Z(Tmax [N] — Tmax_ave)?) # sqrt: square root

N : Number of cycles
Tmax : Maximum cylinder gas temperature (°C) (calculated value)
Tmax_ave : Averaged maximum cylinder gas temperature (°C) (calculated value)

64. Tmax_cov
Rate of change in maximum cylinder gas temperature (%)
Tmax_cov = (Tmax_std / Tmax_ave) x 100

Tmax_std : Standard deviation of maximum cylinder gas temperature (°C)
(calculated value)
Tmax_ave : Averaged maximum cylinder gas temperature (°C) (calculated value)

65. dQ6 ave [720]
Average rate of heat release (J/deg)
dQ6 ave[720] = (1 / N) x =(dQ6 [720,N])

N : Number of cycles
dQe : Rate of heat release (J/deg) (calculated value)
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5.1 Explanation of Equations

66. dQmax[N]

67. 6dQmax[N]

68. 6dQmax_ave

69. dQmax_ave

70. dQmax_std

71. dQmax_cov

72. Q6 ave [720]

Maximum rate of heat release (J/deg)

dQmax|N] = max(dQ6 [720,N])
# max: Indicates the maximum value within the manually input search range of the
maximum rate of release.

N : Number of cycles
dQe : Rate of heat release (J/deg) (calculated value)

Crank angle at maximum rate of heat release (CA)
6dQmax[N] = pos(dQ6 [720,N])  # pos: crank angle at maximum rate of heat release

N : Number of cycles
dQeo : Rate of heat release (J/deg) (calculated value)

Averaged crank angle at maximum rate of heat release (CA)
6dQmax_ave = (1 / N) x Z(6dQmax [N])

N : Number of cycles
6dQmax : Crank angle at maximum rate of heat release (CA) (calculated value)

Averaged maximum rate of heat release (J/deg)
dQmax_ave = (1/ N) x Z(dQmax [N])

N: Number of cycles
dQmax : Maximum rate of heat release (J/deg) (calculated value)

Standard deviation of maximum rate of heat release (J/deg)
dQmax_std = sqrt((1 / (N-1)) x Z(dQmax [N] — dQmax_ave)?) # sqrt: square root

N: Number of cycles
dQmax : Maximum rate of heat release (J/deg) (calculated value)
dQmax_ave : Averaged maximum rate of heat release (J/deg) (calculated value)

Rate of change (%) in maximum rate of heat release
dQmax_cov = (dQmax_std / dQmax_ave) x 100

dQmax_std : Standard deviation of the maximum rate of heat release (J/deg)
(calculated value)
dQmax_ave : Averaged maximum rate of heat release (J/deg) (calculated value)

Average amount of heat release (J)
Q06 ave[720] = (1 / N) x Z(Q6 [720,N])

N : Number of cycles
Qb : Amount of heat release (J) (calculated value)
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5.1 Explanation of Equations

73. Qmax [N]

74. 6Qmax [N]

75. 60Qmax_ave

76. Qmax_ave

77. Qmax_std

78. Qmax_cov

Maximum amount of heat release (J)

Qmax[N] = max(Q8 [720,N]) # max: maximum value
N : Number of cycles
Q6 : Amount of heat release (J) (calculated value)

Crank angle (CA) at maximum amount of heat release
06Qmax[N] = pos(Q6 [720,N]) # pos: crank angle at the maximum amount of heat release

N : Number of cycles
Q6 : Amount of heat release (J) (calculated value)

Averaged crank angle at maximum amount of heat release (CA)

6Qmax_ave = (1 / N) x Z(6Qmax [N])

suonenbg ﬂ

N : Number of cycles
6Qmax : Crank angle at maximum amount of heat release (CA) (calculated
value)

Averaged maximum amount of heat release (J)
Qmax_ave = (1/N) x Z(Qmax [N])

N : Number of cycles
Qmax : Maximum amount of heat release (J) (calculated value)

Standard deviation of maximum amount of heat release (J)
Qmax_std = sqrt((1 / (N-1)) x Z(Qmax [N] — Qmax_ave)?) # sqrt: square root

N : Number of cycles
Qmax : Maximum amount of heat release (J) (calculated value)
Qmax_ave : Averaged maximum amount of heat release (J) (calculated value)

Rate of change (%) in maximum amount of heat release
Qmax_cov = (Qmax_std / Qmax_ave) x 100

Qmax_std : Standard deviation of maximum amount of heat release (J) (calculated
value)
Qmax_ave : Averaged maximum amount of heat release (J) (calculated value)
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5.1 Explanation of Equations

79. Qab

80. Qab_ave

81. RHO [720,N]

82. RHO ave [720]

Amount of heat release during the combustion period (J)

Qab[N] = Q6 [b,N]
Amount of heat release at point b at each cycle (sum from point a to point b at

each cycle)
N : Number of cycles
Q6 : Amount of heat release (J) (calculated value)
b: End point of combustion. Crank angle (CA) at which the value of dQ6 is

changed to a negative value immediately after dQmax (calculated
value)

Average amount of heat release during the combustion period (J)

Qab_ave = (1/N) x Qab [N]

N : Number of cycles
Qab : Amount of heat release during the combustion period (J) (calculated
value)

Combustion mass rate (%)

RHO [720, N] = Q6 [720,N] / Qab[N]

N : Number of cycles
Q6 : Amount of heat release (J) (calculated value)
Qab : The calculated sum (J) from point a to point b at each cycle

Average combustion mass rate (%)

RHO ave[720] = (1 / N) x Z(RHO [720,N])

N : Number of cycles
RH6O : Combustion mass rate (%) (calculated value)
83. ORH[N]

Crank angle at combustion mass rate N1 % (CA)

(the crank angle such that the combustion mass rate is N1 %)

ORHI[N] = floor(round(RH6[720,N]), ratio)
# floor: the angle whereby RHO is greater than ratio (depending on the angular
resolution)
# round: round to 1 digit after the decimal place
N : Number of cycles
RH6 : Combustion mass rate (%) (calculated value)
ratio : Ratio for judging angle of combustion mass rate N1 % (%) (manually

input)
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5.1 Explanation of Equations

84. 6RH_ave

85. ORH_std

86. 6RH_cov

87. ORH2[N]

88. bBRH2_ave

89. ORH2_std

Averaged angle at combustion mass rate N1 % (CA)
6RH_ave = (1/N) x Z(6RH [N])

N : Number of cycles
6RH : Angle at combustion mass rate N1 % (CA) (calculated value)

Standard deviation of angle at combustion mass rate N1 % (CA)

ORH_std = sqrt((1 / (N — 1)) x Z(6RH [N] — 60RH_ave)?) # sqrt: square root
N: Number of cycles
6RH : Angle at combustion mass rate N1 % (CA) (calculated value)

O6RH_ave : Averaged angle at combustion mass rate N1 % (CA) (calculated value)

Rate of change in angle at combustion mass rate N1 % (CA)

O6RH_cov = (6RH_std / 6RH_ave) x 100

suonenbg ﬂ

6RH_std:  Standard deviation of angle at combustion mass rate N1 % (CA)
(calculated value)
O6RH_ave: Averaged angle at combustion mass rate N1 % (CA) (calculated value)

Crank angle at combustion mass rate N2 % (CA)
(the crank angle such that the combustion mass rate is N2 %)

O6RH2[N] = floor(round(RH6[720,N]), ratio2)
# floor: the angle whereby RHO is greater than ratio2 (depending on the angular
resolution)
# round: round to 1 digit after the decimal place

N : Number of cycles

RH6 : Combustion mass rate (%) (calculated value)

ratio2 : Ratio for judging angle of combustion mass rate N2 % (%) (manually
input)

Averaged angle at combustion mass rate N2 % (CA)
ORH2_ave = (1 / N) x Z(6RH2 [N])

N : Number of cycles
O6RH2 : Angle at combustion mass rate N2 % (CA) (calculated value)

Standard deviation of angle at combustion mass rate N2 % (CA)
ORH2_std = sqrt((1 / (N — 1)) x Z(6RH2 [N] — 6RH2_ave)?)  # sqrt: square root

N: Number of cycles
O6RH2 : Angle at combustion mass rate N2 % (CA) (calculated value)
6RH2_ave : Averaged angle at combustion mass rate N2 % (CA) (calculated value)
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5.1 Explanation of Equations

90. BRH2_cov

91. 6RH3[N]

92. 6RH3_ave

93. ORH3_std

94. 6RH3_cov

95. PolY® [720]

Rate of change in angle at combustion mass rate N2 % (CA)

6RH2_cov = (BRH2_std / 6BRH2_ave) x 100

ORH2_std : Standard deviation of angle at combustion mass rate N2 % (CA)
(calculated value)
O6RH2_ave : Averaged angle at combustion mass rate N2 % (CA) (calculated value)

Crank angle at combustion mass rate N3 % (CA)
(the crank angle such that the combustion mass rate is N3 %)

6RH3[N] = floor(round(RHB[720,N]), ratio3)
# floor: the angle whereby RHO is greater than ratio3 (depending on the angular
resolution)
# round: round to 1 digit after the decimal place

N : Number of cycles

RH6 : Combustion mass rate (%) (calculated value)

ratio3 : Ratio for judging angle of combustion mass rate N3 % (%) (manually
input)

Averaged angle at combustion mass rate N3 % (CA)
BRH3_ave = (1/ N) x Z(ORH3 [N])

N : Number of cycles
ORH3 : Angle at combustion mass rate N3 % (CA) (calculated value)

Standard deviation of angle at combustion mass rate N3 % (CA)
ARH3_std = sqrt((1 / (N — 1)) x Z(BRH3 [N] — 6RH3_ave)?)  # sqrt: square root

N: Number of cycles
ORH3 : Angle at combustion mass rate N3 % (CA) (calculated value)
O6RH3_ave : Averaged angle at combustion mass rate N3 % (CA) (calculated value)

Rate of change in angle at combustion mass rate N3 % (CA)
6RH3_cov = (BRH3_std / 6BRH3_ave) x 100

ORH3_std : Standard deviation of angle at combustion mass rate N3 % (CA)
(calculated value)
O6RH3_ave : Averaged angle at combustion mass rate N3 % (CA) (calculated value)

Polytropic index

PolY6 [720] = — (log1o(PO ave[n-1] / P6 ave [n]) / logio (VO [n-1]/ V6 [n]))
n=0to 719. when n =0, Polyd = 1.

Po ave : Average cylinder pressure (kPa)
Ve : Piston displacement (m®)
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5.1 Explanation of Equations

96. Vmax

97. chX6 ave[720]

95. chXave[N]

99. a ave

100. b_ave

Maximum piston displacement (m°)

When Clearance volume is selected on the Parameter Settings screen
Vmax = Vst + Vc

When Compression ratio is selected on the Parameter Settings screen
Vmax = Vst + (Vst / (Cr-1))

Vst : Piston displacement (m®)
Vce: Clearance volume (m%)
Cr: Compression ratio (manually input)

Other signals (crank angle graph data)
chX6 ave[720] = (1 / N) x Z(chX[720,N])

N : Number of cycles
chX: Measured value of chX

Other signals (cycle graph data)

chXave[N] = ave(chX[720,N]) # ave: average value
N : Number of cycles
chX: Measured value of chX

Average start point of combustion (CA)
a_ave = (1/N) x Za[N]

N : Number of cycles

a: Crank angle (CA) at which the value of dQ6 is changed to a positive
value immediately before dQmax (calculated value)
When manually input, the setting value is assumed to be point “a.”

Average end point of combustion (CA)
b_ave = (1/N) x =b[N]

N : Number of cycles

b: Crank angle (CA) at which the value of dQ#6 is changed to a negative
value immediately after dQmax (calculated value)
When manually input, the setting value is assumed to be point “b.”
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Chapter 6 Monitor Functions (Add-On)

6.1 Overview

This function is an add-on for the Engine Combustion Pressure Analysis Package.
This function is only available when used in conjunction with the Engine Combustion
Pressure Analysis Package.

With the Monitor Function, you can use your WE7000 series instrument (WE7235,
WE7245, WE7271, WE7272, or WE7275) or the DL750 to measure cylinder pressure
over given periods of time during motoring or firing, and continuously monitor the
measurements. You can also save the resultant data.

¢ Monitoring Raw Data (Motoring Data)
« Displays one cycle's worth of raw (measured) data before or after TDC correction.
« If filters were applied, filtered waveforms are displayed.
« The specified number of cycles of raw (measured) data is acquired, then saved in
WVF format.

* Monitoring Analysis Results (Firing Data)
« TDC correction and absolute pressure correction are performed on the data, then
analysis results below are displayed according to monitor items that the user
selects.

Monitor ltems

Crank Angle Graph Monitor  Numerical Value monitor

Cylinder pressure Maximum cylinder pressure and the corresponding crank angle
None P-V graph NMEP
Other Signals IMEP
PMEP
dP Rate of cylinder pressure rise  Maximum rate of cylinder pressure rise and the corresponding
crank angle
T Cylinder gas temperature Maximum cylinder gas temperature and the corresponding crank
angle
dQ Rate of heat release Maximum rate of heat release and the corresponding crank angle
Q Amount of heat release Maximum amount of heat release and the corresponding crank
angle
Combustion mass rate Crank angle such that the combustion mass rate is N1 %

Crank angle such that the combustion mass rate is N2 %
Crank angle such that the combustion mass rate is N3 %
Start point of combustion (point a)
Etart point of combustion (point b)

« [f filters were applied, the filtered waveforms are displayed.
* The specified humber of cycles of data to undergo combustion pressure analysis is
acquired, then saved in WVF format.

« Entering Conditions
Enter the conditions below before executing the monitor function.
¢ Measurement conditions
« Parameter conditions
« Filter conditions

IM 707766-61E
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6.1

Overview

Procedure

Use the monitor function according to the procedure in the figure below.

Start

(section 6.12
Appendix 1,
v Appendix 2)

Configuring
WE7000 or DL750

l (section 6.13

Setting
Measurement Condition

(section 6.10

Setting filter

l (section 6.7)

Monitoring raw data

l (section 6.6)

Saving data

1

~

)

Enter the following settings.

e Channel conditions (use channels 1 through 16)

» Trigger conditions (however, do not use a pretrigger)
* Time base conditions

Monitor Functions
of
Engine Combustion
Pressure

(section 6.14)

Entering
manually input data

l (section 6.10)

Setting filter

1
l (sections 6.8 and 6.9)
1

Monitoring cylinder
pressure after calculation

l (section 6.6)

Saving data

TDC Correction

(section 3.2)

Selecting afile

l (section 3.13

TDC Correction
Setting calibration factors
Setting channels

)

Engine Combustion
Pressure Analysis

Combustion
pressure analysis

(section 3.2)

Selecting afile

_———— e ——

l (sections 3.9, 3.10,
and 3,11)f

Performing combustion
pressure analysis

1
1
1
l (section 3.3) :
1
1
1

Saving analysis results
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6.1 Overview

Processing
The monitor function operates as shown in the figure below.
<Motoring Mode>

Data acquisition

!

Filter processing

A4

Rotational offset correction

[ Rotational offset correction and TDC

L 4 correction are the same process as
TDC correction in the Combustion Pressure Analysis
Package.

<
<

A4

Crank angle graph display

<Firing Mode>

}

Data acquisition

!

Filter processing

(uO-ppv) suonoung J0NUON

A

Rotational offset correction

[ Rotational offset correction and TDC

v correction are the same process as
) in the Combustion Pressure Analysis
TDC correction Package.
v
Absolute pressure
correction
Calculation
I
Graph display Numeric display

” I
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6.2 Setup

Installing the Software
Use the setup program on the CD to install the Monitor Function.
Run the file, CD DrivelDisk1/Setup.exe.
Use the same destination folder for the installation that you used for the Engine
Combustion Pressure Analysis.
If your operating system is Windows NT, 2000, or XP, log in as the administrator.

Hardware Configuration
Please see the appendix.

IM 707766-61E



6.3 Screens

Change to this function by choosing File > Start Monitor Functions (see section 3.6).
You can also change to this function when the menu bar of the Engine Combustion
Pressure Analysis is displayed by selecting (activating) a window related to the monitor
function.

Menu Bar of the Monitor for the Engine Combustion Pressure Analysis Package

File menu

Edit menu

View menu

Settings menu
Calculation menu
Monitor menu
Graph menu
Window menu
Help menu

lication Software Package for Anzlysis of Engines' Combustion Pressure - Moniter - |EI|1|

IR R B RO I Ik
|

Help (display user's manual)
Restore the minimized window
Minimize the window
Save screen to BMP file
Move cursor
Save data to WVF file
Stop monitoring
Start monitoring
Enter measurement conditions
Enter setup conditions
Start monitor function
Enter color settings
Enter cycle display settings
Enter axis range settings
Enter 3D graph settings
Execute calculation
Enter parameter settings
TDC and calibration factor settings
Enter filter settings
Save analysis conditions
Load analysis conditions
Save to CSV file
Load waveform data

(uO-ppv) suonoung J0NUON
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6.4 Common Operations

The following operations can be performed when monitoring is interrupted.

Right-Clicking the Mouse

Measured Data 3
Crank angle graph 3
Cyele graph 3
Mumeric analysis data items

3D graph

Axis range

Display channels 3
Cycles

Graph colors

If you right-click on a window displaying a graph, you can execute the following

commands from the pull-down menu.

* Measured Data: Opens a window displaying a crank angle graph of raw data and
corrected data. You can enter these settings while monitoring is being performed.

« Crank angle graph: Opens a window displaying a crank angle graph of calculated
analysis items. You can enter these settings while monitoring is being performed.

* Numeric analysis data items: Opens a window displaying numeric analysis results
from calculated analysis items. You can enter these settings while monitoring is being
performed.

« Axis range: Displays the graph axes setting screen. You can manually enter a fixed
value for the X and Y axes, or choose Autoscale.

« Display channels: Displays a pull-down menu for display channels.

e Graph colors: Displays the graph color setting screen.

Moving the Cursor
Values can be read in directly using the cursor. If you click in a window displaying a
graph, the cursor (a vertical bar) jumps to the point where the mouse was clicked, and
the X and Y axes of that point are displayed. Cursors (displayed as vertical bars) can be
moved from left to right.

4 : Fast left cursor
q : Left cursor

> : Right cursor
W

Fast right cursor

Displaying the Mouse Pointer Position
When the mouse is moved over a graph, the X and Y value of the current position is
displayed on the graph.

Save Screen to BMP File
When monitoring is interrupted, press the | g button to save a bit map image of the

active graph window.

Displaying Help Information
When monitoring is interrupted, you can display the user's manual in PDF format.

6-6 IM 707766-61E



6.5 File > Load Measured Data

Functions

* This is the same function as the one described in section 3.2, “File > Load Measured
Data.”

* You can select and load previously saved waveform data files. You can analyze
previously saved analysis data while monitoring.
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6.6 File > Save Monitoring Results

Functions

< Automatically pauses monitoring, acquires the specified number of cycles according
to the measurement conditions, and displays the File Save dialog box. The saved
files contain raw (measured) data that has not undergone TDC correction or filtering.
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6.7 View > Measured Data

Functions

 Filters are applied to raw (measured) data according to the filter conditions, which is
then displayed in the crank angle graph.

« The following shows the contents of the display for each command.
View > Measured data > Raw data: Raw (measured) data before TDC correction
View > Measured data > Corrected data: Raw (measured) data after TDC correction

(uO-ppv) suonoung J0NUON H
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6.8 View > Crank Angle Graph

IE Crank angle graph - Cylinder pressure (kPa) - |EI|1|

5215.000
Current CH
CH1
Current Cycle \
;iner \\_ﬁ_,_\___,_.m.—.._..m.—v—"’ T T
-199.000
-360.00 0.00 360.00
Crank angle(Ca)
H-axis Y -gxis
IMaximum cylinder pressure (kPa) j| 496821364003 | 136000 0. | 311.163
Functions
« Displays a crank angle graph of the combustion pressure analysis results being
monitored.

« The selected values from the numeric analysis data items and the measurement items
set to Use in Calculations in the Parameter Setting screen are displayed in the lower
left portion of the screen.
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6.9 View > Numeric Analysis Data ltems

7 Mumetic analysis data items 10l =|
4482534e+003 & Angle 19.00 g
{ Maximum rate of cylinder pressure Hse kParden  Angle CA
o 947675664002
" MEP 116323064003
" PMER 2155546e+002  |pg,
€ Maximum cylinder gas temperature degl  Anole CA
€ Maximum amount of hest release J ) Angle A
€ Maximum rate of hest release Jidey ) Angle A
 Angle &t combustion mess rate M1 % CA o Start point of
[ Angle st combustion mass rate M2%% CA combu.sﬂon(pomt &)
End point of
= Angle &t combustion mass rate ME25 CA combustionipaint b CA
7000.000
A0 A0 fal

Currert CH \\/ V \\/ I"."II lll

CH1

Fitter

3000.000
Ptk (kPa) [
Functions

« Displays numeric analysis data items of the combustion pressure analysis results.

* One of the numeric analysis data items is displayed as a trend.

* The selected values from the cycle graph data items and the measurement items set
to Use in Calculations in the Parameter Setting screen are displayed in the lower right
portion of the screen.

(uO-ppv) suonoung J0NUON
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6.10 Settings > Filter

Functions

« This is the same function as described in section 3.12, “Settings > Filter.” You can
enter these settings when monitoring is paused.

* The settings take effect when monitoring is resumed.
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6.11 Settings > TDC Correction and Calibration
Factor Settings

Functions

e This is the same function as the one described in section 3.13, “Settings > TDC
Correction and Calibration Factor Settings.” There is no execution function for
calculation of the TDC correction value. It is manually input.

* The settings take effect when monitoring is resumed.

(uO-ppv) suonoung J0NUON H
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6.12 Settings > Setup

Functions
* This is the same function as described in section 3.6, “File > Start Monitor Functions.”
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6.13

Measurement Conditions Setting ll

Angular Resolution &+ 1CA 05CA  025CA{ 01CA

Mo. of Cycles to
Acguire/Save

Select tems to Monitor [~ dp T

In motaring mode:

Combustion mode

Settings > Measurement Conditions

Cda [ a

Cancel |

Functions

* With monitoring stopped, you can enter the angular resolution and number of cycles
to be acquired and saved.
« Select the monitor items. The settings take effect when monitoring is resumed.

Monitor ltems

Crank Angle Graph Monitor

Numerical Value monitor

Cylinder pressure

Maximum cylinder pressure and the corresponding crank angle

None P-V graph NMEP
Other Signals IMEP
PMEP
dP Rate of cylinder pressure rise  Maximum rate of cylinder pressure rise and the corresponding
crank angle
T Cylinder gas temperature Maximum cylinder gas temperature and the corresponding crank
angle
dQ Rate of heat release Maximum rate of heat release and the corresponding crank angle
Q Amount of heat release Maximum amount of heat release and the corresponding crank
angle
Combustion mass rate Crank angle such that the combustion mass rate is N1 %
Crank angle such that the combustion mass rate is N2 %
Crank angle such that the combustion mass rate is N3 %
Start point of combustion (point a)
Etart point of combustion (point b)
Setting/Display Data
No. Item Initial Value Data Size Numeric Data Input (1) /
Type Min. Value Max. Value Select (S)
Angular Resolution Prev. value - - - - S
No. of Cycles to Prev. value | 3.0 1 800 |
Acquire/Save
3 Select Items to Monitor Prev. value - - - - S

(1) Angular Resolution: You can select 0.1, 0.25, 0.5, or 1.
(2) No. of Cycles to Acquire/Save: Input the number of cycles to acquire.

Button Operations
OK Button

Activates all on-screen settings, and closes the window.

Cancel Button

Clears all on-screen settings, and closes the window.

IM 707766-61E
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6.14 Calculation > Set Parameters

Functions
* This is the same function as the one described in section 3.14, “Calculation > Set
Parameters.”
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6.15 Monitor

Functions
» Starts and stops monitoring.

IM 707766-61E
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6.16 Graph

Functions

» These are the same functions as the ones described in section 6.4, “Common
Operations.”
They include axis settings, displayed channels, and graph color settings.
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Chapter 7 Error Messages

7.1 A List of Error Messages

The messages in the table below appear in response to errors that may occur.

Messages Description
Failed to acquire ASCII header information. .hdr file not found.
Failed to create analysis work data. wvf file does not exist, or WVF file format incorrect.

Setup information is not correct or power to the instrument is not ON. -

The range defined by the start cycle and end cycle settings exceeds -
the number of effective cycles.
Please reenter the values.

Start cycle cannot be greater than the end cycle. -

Application has already started. (Two simultaneous sessions prohibited.) -

The default drive may have insufficient free space. Analysis results -
may not be able to be saved. OK to continue?

Analysis results not saved. Save the results? -

The measuring instrument of the selected waveform data does not match!! -
If you continue, the data may not be displayed or calculated correctly.
Do you still wish to continue?

X axis range not entered correctly. -

Y axis range not entered correctly. -

lllegal setting value. The input value exceeded the upper or lower limit
for the setting. 7
Failed to load the analysis conditions. The format of the analysis file (.ecp) is incorrect.

Cannot exit during monitoring. -
Please stop monitoring before exiting.

sobessa 10113
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Appendix

Appendix 1 Setting Up the WE7000

First, enter all necessary settings on the WE7000 control software.

The following is an example of how the WE7000 would be configured to measure the
pressure in one cylinder assuming one WE7272 module is installed, and a PC is
connected.

Sigmal Connection

TRIGIN: Angular pulse
(TTL level signal)

CHZ1: Cylinder pressure
CH2: TDC pulse

xipuaddy 'g
©
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Appendix 1 Setting Up the WE7000

<Module Settings>

@

@

©)

4

®)

)

@)

®)

©

On
Connect cylinder pressure signals in the firing order starting from channel 1.
Connect the TDC pulse signal to a channel not being used for cylinder pressure
measurement.
In this example, CH1 is assigned to cylinder pressure, and CH2 is assigned to
TDC pulse.
Range
Set the measurement range appropriate for the input voltage.
Trig Type
Uses the TDC pulse signal as the trigger.
Set CH2 to Rise or Fall.
Turn CH1 (cylinder pressure measurement) off.
Trig Level (V)
Set the trigger level on the channel connected to TDC pulse (CH2).
Filter
Set when the low pass filter is applied as analog processing.
Acquisition Mode
Select Triggered.
Memory Partition
Set to 1.
This is automatically set with the Monitor Function add-on for the Engine
Combustion Pressure Analysis.
Record Length
Enter settings as follows:
Record length = (no. of analyzed cycles + 3) x 1 cycle data length
For 4-cycle engine: 1 cycle data length = (360/res) x 2
For 2-cycle engines: 1 cycle data length = (360/res)
res = angular resolution (1, 0.5, 0.25, 0.1)
For example, with a 4-cycle engine at an angular resolution of 0.5 CA, and 100
cycle’s worth of data acquired:
From the equation: Record length = (100+3) x 1440 = 148320, enter 148320.
This is automatically set with the Monitor Function add-on for the Engine
Combustion Pressure Analysis.
No. of Acquisitions
Setto 1.
This is automatically set with the Monitor Function add-on for the Engine
Combustion Pressure Analysis.
1) &) 3 4 ©)

on Data Range Trig Type Trig Level(¥} Filter

o X | 000 [sv [x|lof x| = 000 [om @
(6) cH2 & | 0.00 Isv d IRise ﬂ ﬂ 1.00 IOff /

cHs [ | FryeTs |35\; =l IOff =l j oG I}/ / ®)
o [ [ [ [on =l :I/{ [ore

Acquisition Mode Memony PartitionK / (9)

{* Triggered m /ﬁr ] =

£ FreeRun / 5 RBPQ(

€ Gate(Level) RA""""’ LEmmid

" Gate(Edge} EI 2000

Sampling Interval Ho. of Acquisitions

= wf= -1 = 1

App-2
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Appendix 1 Setting Up the WE7000

(10) Trigger/Source
Select Internal.

(11) Misc/Time Base
Select BUSCLK.

(12) CH Mode
Select the number of measurement channels depending on the number of input
channels.

(13) Overlapped Acquisition
Unselected

(14) Pretrigger
Setto 0.

10
(10) 11 (12)

Station/Slat 7 WET272 zolated Digitize

Time Base
" Internal
{* BUSCLK

Hold Off = 72000 | samples I_ Overlapped Acquisition

7 Trig |
Trigger

Source Combination
' Internal " AHD
N ~ BUSTRG * OR

Pretrigger.

14

(13)

Acquigition Mode.
{* Triggered

£ FreeRun

Memory Partition

m Start Iﬂ

I?Repeat
€ Gate(Level) BecordCenath
-
" Gate(Edge}) _T_i 12000
Sampling Interval Ho. of Acquisitions

g okd A

xipuaddy 'g
©
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Appendix 1 Setting Up the WE7000

<Trigger Information Settings>
Enter the following settings for the TDC pulse trigger signal and the angular pulse
sampling signal.

(1) External Trigger Input Switching

Disconnect

(2) Trigger Source Switching
Disconnect

(3) Time base Source
Select TRIGIN.

(4) Time base Signal ON/OFF
Connect CMNCLK to the slot as a time base signal.
(5) Press Update to apply the settings.

Station] Trigeer Info

@)

hdanial Armin
BUSTRG

Marpasl Trigoer
BETRG2

khﬂanual Trigger2 (4)
f

At

il

N\

®

CMNCLK/
II TRIGIN vl
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Appendix 1 Setting Up the WE7000

<Scaling Information Settings>
Set all input signal scaling settings to Not Available.

P1-F: ar+
Setting... Copy | Paste | [~ Save Physical Yalue 5P2 Y-aX+h Y-aX+h
5P1
canceL | ¥P1 WP2

<Sending Settings to the Station>
Right-click the station name for the station list window then select Update Preset Values
from the menu. The above setting conditions can be sent to the station.

Open operation panel
Open monitor panel

Update Prezet Walues
Ihitialize Preset
Execute Preset
Execute Default

Save Setup Data..

Load Setup Data...

Copy Setup Data..
Dizplay Setup Data..
Copy between channels...

Save Acguisition Data..

Open Monitor

Dizplay Update Rate..
Convert Scale..

xipuaddy 'g
©

Start GP-IB window
Custom dizplay.

Module Help

<Exiting the Control software>
Check that you can measure cylinder pressure using the WE7272 and the control
software. Exit the control software. This concludes the setup.
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Appendix 2  Setting Up the DL750

First, enter all necessary settings on the DL750. The following is an example of how the
DL750 would be configured to measure the pressure in one cylinder with one 701251
measurement module.

Signal Connection

31756 seorscvave

| | «€—— CH1: Cylinder pressure

(—CHZ:TDC ulse
Ethernet ——) P

Angular pulse
(TTL level signal)

= = ® O EIE=E ¢
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Appendix 2 Setting Up the DL750

Connect an Ethernet cable to the main unit and turn on the power.

<Network and User Account Settings>
(1) Pressthe MISC key.
(2) Press the Network soft key.
(3) Pressthe TCP/IP Setup soft key. The TCP/IP setup menu is displayed.
(4) Pressthe User Account soft key. The User Account Setting menu is displayed.

MISC —} MISC CE/IE Getup
System Config TCP-IP DHCP | OFF PN

Setup
1P pddress [ 16.] €.} 99.}149
Remote Cntl User Het Mask p55|.po5.25Y.| 9
Account
Gate Way  [TO. O[T
SCSI ID Mail Setup NS OFF

Network [ Net Drive

Setup

USB List Net Print
Setup

Duerview Others

Commect User Hane anoninons
Log List
Password
Tine Dutisec) 5

The setup procedure is explained in the DL750 user’'s manual. Also, you must enter the
network information and user account information that you set here in the Monitor
Function add-on for the Engine Combustion Pressure Analysis (see section 6.2).

After entering the above settings, enter the DL750 IP address in a web browser and
confirm that the screen below is displayed.

xipuaddy 'g
©

YOKOGAWA 4 Test and Measurement

Measurement Instruments Web Service

Contents

e
e e e g e e e

DL.750 %m'
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Appendix 2 Setting Up the DL750

<Remote Control Settings>

Set so that remote control is available through the network.

MISC

System Config

Remote Cntl
SCSI ID

USB List

Duerview

Remote Cntl

Device

Network

Account

Network

lser Hane

Passuord

Tine Dutisec)

anonynous

Inf inite

App-8
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Appendix 2 Setting Up the DL750

<CHL1 (Cylinder Pressure Signals) Settings>
Choose a range using the V/DIV knob. Also, press the CH1 key to enter settings for
CH1 as follows:

Linear Scale

OFF * Linear Scale = OFF

CH1 |—> pmcrwes —>
OFF PN Label = CH1

IIIIiIiiiiiIIII

Variable Invert
OFF
@ Position

DFF ON
0. 20div

Coupling Label
Probe

Banduwidth
Full

T U Zoom
¥ 1
w Offset
B.0my

<CH2 (TDC Pulse Signal) Settings>
Choose a range using the V/DIV knob. Also, press the CH2 key to enter settings for
CH2 as follows:

CH?2 A —>

Display

Linear Scale

OFF * Linear Scale = OFF
Label = CH2

OFF pH

Variable
OFF
@ Position
0. 20div

Coupling
Probe

Invert

DFF ON

Label

xipuaddy 'g
©

Banduwidth

Full
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Appendix 2 Setting Up the DL750

<Trigger Mode Settings>
Press the MODE key to set the trigger mode to Single. This is automatically set with the

Monitor Function add-on for the Engine Combustion Pressure Analysis.

<Trigger Settings>

Press the SIMPLE/ENHANCED key, and set the TDC pulse signal (CH2) to the trigger

source. Enter the Level, Slope, and Hysteresis for the TDC pulse signal.

<Pretrigger Settings>

Press the POSITION key to set the Position to 0.0%.

MODE

SIMPLE/ENHANCED

POSITION

Auto

Level

SIMPLE (Edge)

Select
Siope
@ Level

1.3 v

Hysteresis

v

©§ Hold OFF

0.3us

v

POSITION

[@ Position

5.0

Set to 16z
Set to 50z

Set to 90z

App-10
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Appendix 2 Setting Up the DL750

<Waveform Loading Settings>
Press the ACQ key to set the record length and time base.
Enter settings as follows for the record length.
Record length = (no. of analyzed cycles + 3) x 1 cycle data length
For 4-cycle engine: 1 cycle data length = (360/res) x 2
For 2-cycle engines: 1 cycle data length = (360/res)
res = angular resolution (1, 0.5, 0.25, 0.1)
For example, with a 4-cycle engine at an angular resolution of 0.5 CA, and 100 cycle’s
worth of data acquired:
From the equation: Record length = (100+3) x 1440 = 148320, enter 250 k.

This is automatically set with the Monitor Function add-on for the Engine Combustion
Pressure Analysis.
Set Time Base to Ext so that the angular pulse signal will be used as the EXT-CLK.

ACQ ) ‘@Record Length

1k

o
=

Hode

Normal

Time Base
Ext

[FPulse Rotate

xipuaddy 'g
©

<Concluding Setup>
Confirm that cylinder pressure can be measured using the START/STOP key. This
concludes the setup.
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Index

cascading fashion ..........cccoceiiiiiiiini s
Channel NAMES .........oooiii e
clearance volume........
combustion mass rate
combustion period ...........cccocieiiiiiennen. .

combustion pressure analysis data items ............c.cccocvenee.
COMIMENES ...ttt e e sreenees
communication INterface ...........ccccvvveeiiieeiiiee e
COMPIESSION FALIO ...ecvviiiiiiiieeiiee e

COMPression/expansion WOrk ...........ccccceeereireeneeeneeneeenns
CON-rod 1ENGLN L...ooiiiiii e

corrected gas Constant .........c.cceeveveerieneenn
crank angle at combustion mass rate N1 % .
crank angle at combustion mass rate N2 % ....

Symbols

.csv

.ecm

.ecp

3D graph

A

A (calibration factor) .........cccccevieniiiiie e 3-18
ADOUL ECP ...ttt 3-2
absolute pressure Correction ..........ccoeovvriveneeniieenec e 2-4
amount of heat release ..........cccccvevveeeveecnnnnenn.. 5-16, 5-20, 5-22
amount of heat release during the combustion period ...... 5-26
analysis CONAItIONS ........cceerveiiiiriieiie e 2-8
analysis data items graphed in 3D ................ ..2-5
analysis results of a specified range of cycles ................... 2-8
angular reSolUtioN .........ccceeviiveeriiee e 3-3, 6-15
AITANGE ICONS ..tiiiiiiiieiie ettt 3-28
AtMOSPNENIC PrESSUIe .....ooeiiiiiiiiiee et 3-22
atmospheric teMpPerature ..........cccocvevieeneeiiieenie e 3-22
average amount of heat release ...........ccccocevvvveeviieeennnen. 5-24
average amount of heat release during the combustion ... 5-26
average combustion Mass rate .........cccceevveeeeiieeesiieee s, 5-26
average cylinder gas temperature ..........cccceevevveenieeennenn. 5-23
average Cylinder PreSSUre ........ocveeoiveenieeeesiee e 5-2
average cylinder pressure (absolute pressure correction) .. 5-1
average end point of combustion ..........ccccceeviiieeviieeennen. 5-29
average intake manifold pressure ..........ccccveeeeviieennieeennne 5-1
average rate of cylinder pressure rise ........cccccoovvercveeceenne. 5-3
average rate of heat release ................... ... 5-23
average start point of combustion .................... ... 5-29
averaged angle at combustion mass rate N1 % .. .. 5-27
averaged angle at combustion mass rate N2 % ............... 5-27
averaged angle at combustion mass rate N3 % ............... 5-28
averaged angle at maximum amount of heat release ....... 5-25
averaged angle at maximum rate of heat release.............. 5-24
averaged IMEP .........ooiiiiiiiee e 5-8
averaged maximum amount of heat release ..... ... 5-25
averaged maximum cylinder gas temperature .. ... 5-23
averaged maximum cylinder pressure ..........ccccoeeveerineeene 5-4
averaged maximum rate of cylinder pressure rise .............. 5-6
averaged maximum rate of heat release ............ccceeeeueen. 5-24
averaged NMEP ... 5-8
averaged PMEP ... 5-10
E I £ T o PSRN 3-1, 6-6
B

B (calibration factor) ....

BMP file ....cccoiiieiiins .

DOOSE PrESSUIE ...
DOOSE tEMPErALUre ..ot

DOTE <.

C
PP EUPT O PPPRPRNE i
calculated TDC correction value .

[o2= 110 - L1 [0 o USRS
calibration factor ..........ccccevviii i

crank angle at combustion mass rate N3 % .........c.ccc......
crank angle at maximum amount of heat release .............
crank angle at maximum cylinder gas temperature ..........
crank angle at maximum cylinder pressure ............ccc.c.c.....
crank angle at maximum rate of cylinder pressure rise ....
crank angle at maximum rate of heat release ...................
crank angle graph ........ccocceviiieiniie i 3-1, 3-12, 6-6, 6-10
crank angle graph data items (.csv file) .......ccccocvvniniinnnn. 4-3
crank angle graph data of specified range of cycles ........... 4-5
CUPSOE it e e n e e e e e e e e e e e e e e e e e e e e e e e e e e eeaeeaaeeanees 3-2
CUTISOT (IMONITOT) ...ttt 6-6
CULOTE e 3-16
cycle graph ... 2-5,3-1,3-14
cycle graph data items (.CSV file) ......cccooviriiiieiiiiiie 4-3
CYCIES v 3-2
cylinder gas temperature .............. ..5-22
cylinder head wall temperature ..........c.ccocveevieriienicnineenns 3-21
CYlINAEr PreESSUIE .....eeeiiiiieiiiit et 5-1
cylinder pressure after absolute pressure correction .......... 5-1
cylinder wall temperature ..........c.ccocvevieneeieenieeenees 3-21
cylinder-to-cylinder TDC COrrection ...........cccovveeerieieeennnen. 3-18
D

data NAME ...ooiiicic e 3-5
AALA LYPE et ii
AEPANMENT ..o
IreCtory StrUCLUIE ........ccvveiiiiiiieiiiceiecere e
display channels ...
DL708E/DLT716 ....ovviuiiiiiieeiieeiiesieeee st siee st
DL750 ..ooovvvviieiene

DL750 IP address ...

DL750 USB ID .veiiiiiieiieciie ittt

E

endcycle ..o .. 3-3
end point of combustion ...................... ..3-22
engine combustion pressure analysis .........ccccovvveereerneene. 1-3
eNgiNe MOTE! ....coiiiiiiiiiiie e 3-5
entering CONAILIONS .........eveiiieeiiieeeie e 6-1
€XCESS AIr fACTON .....eiiiiiiiiiic e 5-12
exhaust gas pressure.... 321
exhaust gas temperature .........cccceeveeeiiieeeniieee e 3-21
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method of absolute pressure correction ...........c.cccceeeeeeeen. 3-22
minimize all windows .............cccoceeeeee. .3-29
minimum value of IMEP ...........ccccviiiicniienice, 5-9
monitor function of engine combustion pressure ... 1-4
monitoring analysis reSultS ...........ccocvevoieriienie e 6-1
MONItOriNG raW data ........coceeviieiiiiiieeeeee e 6-1
MOLONNG ALA ...ooevieeiiiiee et 6-1
MOUSE POINEEr POSItION ....cvviiriiiiiiiee e 3-2,6-6
N

NEE MASK ...eviiiiiii s 3-9
NIMEP ..ottt 5-7
no. of cycles to acquIre/Save ...........cccocvvvceenieeiiecnieee 6-15
no. of effective CYCIeS .......ccoei i 3-3
non-overlapping fashion ...........c.cccooviniiii 3-27
number of cylinders .........occceevviee e 3-18, 3-21, 3-22
number of data items for judging end point...............c....... 3-21
number of data items for judging start point.. .3-21
nUMbBET Of SITOKES .....cciuviiiiiiiiciiccec e .3-8
numeric analysis data items....... ... 2-6, 6-6, 6-11
numeric data items (.CSV file) .......ccoviiiiniiiiiiii 4-2

O

F
e i
filter .....cc.... ....3-16, 6-12
filter PrOCESSING ...couvvieiiiiie et 2-2
fIIEEI TYPE e 3-16
fIFNG dALtA ..eeeeiiiiee e 6-1
fuel coNSUMPLION ......ccooviiiiiii i 3-21
G

0AS CONSEANT .....ccoiiiiiiiiiiicc e 3-21
0as teMPErature .........ccceveeeveiiiirieeee e 5-14, 5-17, 5-20
Oraph COIOIS ....oiiiiiiee e 3-2,6-6
graph SEHNGS ...ccveeiiiiiieiie e 6-18
H

help iNformation .........cccceciieiiiie e 3-2,6-6
I

PSPPSRI ii
IMEP ...t 5-8, 5-9
L

LNV Of IMEP ..ot
load analysis CoONditioNS ..........cccoeeiiiiiiiiiee e
load measured data .............ccoevieiiiiiinii

loading measurement data ..................

logarithmic average cylinder pressure ....

logarithmic cylinder pressure ............... .
logarithmic piston displacement ...........ccccvvvriienieiniicnnene
low heat value ..........cccceeiiiiiiiii e

M

MAUN MENU ..ttt 3-2
manually input data items .................... ...2-6
manually input data items (.CSV fil€) .........ooeieeiiiiiiiiiiiiens 4-1
Mass Of iNtaKe A ......ccovviriiiiii e 5-11
mass of intake fuel ... 5-11
Mass of reMainNing gas .......ccovueeeiiieeeniiee e 5-12
maximum amount of heat release .............coccevcveeiecnneennn. 5-25
maximum cylinder gas temperature ............cccccveveeerneenne
maximum cylinder PreSSure ..........cccccveeeeiiieeeniiee e
maximum piston displacement................

maximum rate of cylinder pressure rise ..

maximum rate of heat release ................

measured data .........ccoceeeeieiienieinie e

measured exhaust gas PreSSUIe .........cceeeveeeeerieeenieeeennns
measured exhaust gas temperature ............ccceceeeeeeiineeenns
measured fuel coNSUMPLION ..........ccevviiiiiiicccee
measured intake manifold pressure ........

measured intake manifold temperature ..

measured revolutions per minute............. .
measured supercharger inlet temperature ..............cccee..e. 3-21
measurement data reVIEW ............cocevcvveiiiiiienie e 2-2
measuring MOAUIE ........cccoiiiiiiiiiiericee e 3-9
Measuring iNStTUMENT .........cooiiiiiiiiee e 3-4
MEASUNNG STALION .....c.eviiiiiie e 3-9
MENU DA ... 2-11
menu bar (monitor fuNCLioN) ..........ccccevveeeiiiieenie e 6-5
MESSAYES ...vvvvveeerrrrrieennn. . 7-1

of all cycles and cylinders
averaged crank angle at maximum cylinder pressure .... 5-5
averaged crank angle at maximum rate of cylinder

PrESSUIE TS ...veiuviiirieiieeitee sttt ettt

averaged IMEP ...t
averaged maximum cylinder pressure..........cccccoeeveeneene
averaged maximum rate of cylinder pressure rise
averaged NMEP ...
averaged PMEP ...t

of all cylinders
averaged crank angle at maximum cylinder pressure .... 5-5
averaged crank angle at maximum rate of cylinder

PrESSUIE NS ...eeivviiirieieeeiiee ettt ettt

averaged IMEP ...
averaged maximum cylinder pressure.................
averaged maximum rate of cylinder pressure rise
averaged NMEP .......ccccoiiiiiniiiccecee
averaged PMEP ...t

Other SIgNaIS .......cooeiiiiic

other signals (.csv file) ......ccccceennenennn

other signals (crank angle graph data) ... .

other signals (cycle graph data) .........c.cccocvevieiiicniciiiens

PAFAMETENS ...ttt 3-20, 6-16
PASSWOIT: ...ttt 3-9
PC-IP address .......ccoeiiiiiiiiiicciceee e
piston displacement ...........ccccceeeiiiiiienicniee

piston head ratio ...........cccoceenee.

piston head wall temperature
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